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1 
Introduction 

This chapter introduces you to ImageScope, discusses its 
features, and tells you where to go in this guide to find 
information on specific features. 

ImageScope Features 
Although ImageScope™’s basic function is to allow you to view digital slides 

created by a microscope slide scanner from glass tissue slides, it offers much 

more: 

 View digital slides from any workstation on the network, eliminating the 

delay of physically transporting glass slides from one department to 

another. 

 Share and discuss digital slides in real time in multiple remote locations 

by using digital slide conferencing. 

 View multiple digital slides concurrently. 

 Apply image adjustments in real time for contrast, brightness, and 

gamma. 

 Analyze entire digital slides or selected regions using provided, 

purchased, or custom algorithms*. 

 Interface directly to a ScanScope scanner through a network connection 

to view slides “live” and in different focal planes†. 

 Rotate digital slide images and labels. 

 Use Aperio Integrated Color Management to view digital slides to 

ensure the digital slides are displayed in accurate color. 

 Use the Image Quality (IQ) feature to optimize viewing of a digital slide 

based on its stain. 

 Annotate digital slides, making use of these features: 

 Multiple drawing tools 

 Ability to draw areas to be excluded from analysis* 

 Organize annotations by person or department by creating 

annotation layers 

 Link annotations or images to create a viewing sequence 

 Add text and descriptions to annotations 

 Export and import annotations 
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 Interface to Aperio’s ImageServer™ and Spectrum™. 

 Instantly pan and zoom to any region of the slide.  

 Extract a region or selected regions of a digital slide to a file in a choice of 

formats. 

Types of Files You Can View 
You can use ImageScope to view: 

 ScanScope Virtual Slides – These are .SVS files created when the 

ScanScope scanner scans glass microscope slides. 

 JPEG files – Both .JPG and .JP2 files. 

 TIFF and TIF files. 

 CWS files – Composite WebSlides1. 

 Hamamatsu NanoZoomer files  – NanoZoomer file formats supported 

are: NDPI, .VMS, and .VMU files. Slide label images are not available for 

these images in Spectrum, ImageScope, Digital Slide Studio, and 

WebScope, as these images do not contain labels. 

 Zeiss Mirax files –  Zeiss Mirax image file formats supported are .MRXS 

and SlideDat.ini. (Note that Mirax images are composite images that 

consist of a group of .DAT files. Either the .MRXS or SlideDat.ini file can 

be opened to open the composite image.) 

 ScanScope image set, .sis file – The ImageScope image view is what you 

see when one or more digital slides are being viewed in the ImageScope 

window. When using ImageScope, you can save the image view as a 

ScanScope image set so that you can open all the slides at once in the 

future. 

For More Information 
Here is where to go in this guide for information on ImageScope features. 

How do I… Go to… 
Install ImageScope? Chapter 2, “Installing ImageScope” on page 5. 
Register ImageScope? Chapter 2, “Installing ImageScope” on page 5. 
View digital slides? Chapter 3, “Opening a Digital Slide” on page 11; 

Chapter 4, “Viewing a Digital Slide” on page 27. 
View Pathology News and 
configure it? 

Chapter 2, “Installing ImageScope” on page 5. 
Chapter 19, “ImageScope Options” on page 173. 

                                                           

1A Composite WebSlide, also known as a CWS slide, is a proprietary format created by Bacus 
Laboratories, Inc (“Bacus”). WebSlide® is a registered trademark of Bacus Laboratories Inc. 
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How do I… Go to… 
Enable or disable clinical viewing 
mode 

“Clinical Viewing Mode” on page 28. 

Make annotations and link 
annotations or digital slides to 
make a viewing sequence? 

Chapter 9, “Annotating Digital Slides” on page 75; 
Chapter 10, “Using the Annotations Window” on 
page 81;  
Chapter 11, “Linking Annotations and Digital 
Slides” on page 99. 

Use algorithms to analyze* digital 
slides? 

Chapter 14, “Analyzing Digital Slides” on page 
119. 

Use the algorithm* tuning 
window to test algorithm 
parameters? 

Chapter 15, “Registering Algorithm Macros on 
Spectrum” on page 133. 

Create algorithm* macros? Chapter 15, “Registering Algorithm Macros on 
Spectrum” on page 133. 

Share slides with others in real 
time? 

Chapter 16, “Digital Slide Conferencing” on page 
145. 

Adjust image color, brightness, 
contrast, and gamma? 

Chapter 6, “Making Image Adjustments” on page 
47. 
Chapter 7, “Working with Fluorescence Digital 
Slides” on page 55 

Set and view image resolution? Chapter 8, “Image Resolution” on page 71. 
Track movements through a 
digital slide? 

Chapter 12, “Tracking” on page 103. 

Rotate images and digital slide 
labels? 

Chapter 5, “Rotating Images and Slide Labels” on 
page 45. 

Save image snapshots and 
extract part of a digital slide? 

Chapter 13, “Saving Digital Slides and Regions” on 
page 109. 

View a specimen in various focal 
planes directly on the ScanScope 
scanner†? 

Chapter 17, “TelePath Live” on page 155. 

View live video from the 
ScanScope scanner†? 

Chapter 17, “TelePath Live” on page 155. 

Fine-tune performance? Chapter 19, “ImageScope Options” on page 173. 
Debug and troubleshoot? Chapter 18, “Utilities and Diagnostics” on page 

167. 
Use keyboard shortcuts for 
ImageScope commands? 

Appendix A, “Keyboard Quick Reference” on page 
189. 

Use Aperio Integrated Color 
Management? 

“Viewing with Color Management” on page 38. 
Appendix B, “Aperio Integrated Color 
Management” on page 193. 
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2 
Installing ImageScope 

This chapter contains information on installing the client 
software for ImageScope. 

Before You Start 
This guide covers 
client installation of 
ImageScope. If you 
are installing other 
Spectrum 
components, see the 
Notes and News for 
the latest release or 
obtain the user 
guide for the 
application in 
question for 
instructions. 

Before installing ImageScope, make sure your workstation satisfies these 

requirements: 

 Operating System – Windows 2000, Windows XP, or Windows 7 

 Memory – At least 256MB 

 Hard Disk – Must have at least 30MB of free hard disk space 

 CPU Speed – 450 MHz or faster 

 Video Card – Must support at least 24‐bit color resolution 

 Monitor – Resolution should be at least 1024X768 

Security Alerts 
If during installation you see popup messages from Microsoft or third‐party 

firewall, VPN, or virus software telling you that the installation has been 

blocked, you should consult your network administrator for help resolving these 

issues before continuing. 

Administrative Privileges 
Before running the installer, make sure you are logged onto Windows as a user 

who has administrative privileges; otherwise, the installation will not be 

successful. 
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Installation 
1. Double‐click My Computer or open Windows Explorer and navigate to the 

ImageScope installer file. (This file may have been downloaded from the 

www.aperio.com web site, may have been provided on CD, or may reside on 

your network; contact your network administrator for help if you have 

trouble finding it.) 

If you are installing ImageScope on your DSR (Digital Slide Repository), use 

DSRInstall; if installing ImageScope on a user’s workstation, use 

ClientInstall. 

2. Double‐click the .exe file to start the installer. When using the client installer, 

the following window appears: 

 

3. Click Next to continue. You now see the Aperio software license agreement. 

4. Review the license and then select I accept the terms of the license 

agreement. 
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5. Click Next. The following window appears: 

 

6. Click Next to continue or unselect any components you do not want to install 

and then click Next. The following window appears: 

 

7. We recommend you select Default Install.  
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8. Click Next. A window appears that tells you the installer is ready to install 

ImageScope. 

9. Click Install to continue. A status window informs you of the progress of the 

installation. When the installation is done, you see the completion window. If 

the installer needs to restart your workstation, you see two radio buttons: 

 

If you see these choices, you won’t be able to use ImageScope to view 

JPEG2000‐compressed images until you restart your workstation; we 

recommend you select Yes, I want to restart my computer now and click 

Finish to exit the installer and restart; if you don’t see these choices, simply 

click Finish to exit the installer.  

Modifying or Removing the ImageScope Software 
At any time after ImageScope is installed, you can run the installer again to 

modify, repair, or remove the ImageScope software. If ImageScope is already 

installed, running the installer displays the following window: 

 

 Select Modify to change the ImageScope installation by adding or 

deleting components. 

 Select Repair to reinstall all the components previously installed. This is 

the option to use if you are upgrading a previous installation to new 

software. 
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 Select Remove to uninstall the ImageScope software. 

Starting ImageScope 
To start ImageScope, click Start on the Windows taskbar, point to All Programs > 

ScanScope, and select ImageScope.  

Registering ImageScope 
The first time you start ImageScope after a new install, the Pathology News 

window opens with a registration form. Please type the requested information 

and click Register. By providing this information, you help Aperio to learn more 

about our customers. 

If you do not wish to register at this time, click the Later button to defer 

registering ImageScope for two weeks. You can continue to defer registering 

ImageScope for another two weeks by clicking this button each time the 

registration window appears. 

 

Viewing Pathology News 
ImageScope periodically displays current digital pathology news in a pop‐up 

window when you are opening an image. For example: 

 

The Pathology News content is maintained by Aperio. If the workstation on 

which you are using ImageScope is not connected to the Internet, you will see 
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static content that is installed with ImageScope on your workstation. However, if 

your workstation has an Internet connection, the information in this window will 

be updated on a regular basis to bring you the latest news. 

Any time this window is open, you can click Close on the window to close it. If 

you want to open the Pathology News window again, go to ImageScope’s View 

menu and select View News. To see Pathology News in a separate Internet 

browser window, click Open Page in a Browser on the Pathology News 

window. 

For information on configuring how often to display Pathology News or whether 

to view it at all, see “Pathology News Options” on page 187. 
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3 
Opening a Digital Slide 

This chapter contains information on opening digital slides 
in ImageScope, how to view information about the slide, and 
how to close digital slides. 

Use ImageScope to view: 

 Local digital slides; that is, images that reside on your workstation or 

your local network that are accessible via Microsoft file sharing (for 

example, by using Windows Explorer). 

 Remote digital slides; that is, images that you open directly on an Aperio 

ImageServer or that you open using Spectrum. 

Monitor Requirements 
Because Aperio digital slides are by design high resolution and information rich, 

for best results you should use a high quality monitor to view them. Make sure 

the monitor is at the proper viewing height and in a room with appropriate 

lighting. We recommend any high quality LCD monitor meeting the following 

requirements: 

Display Type: CRT minimum, LCD (flat panel) recommended 
Screen Resolution: 1024(h) x 768(v) pixels minimum 

1920 x1050 or larger recommended 
Screen Size: 15” minimum 

19” or larger recommended 
Color Depth: 24-bit 
Brightness: 300 cd/m2 minimum 

500 or larger recommended 
Contrast Ratio: 500:1 minimum 

1000:1 recommended 

About User Permissions 
ImageScope makes use of Spectrum security to enforce user permissions when 

viewing images. 

The Spectrum administrator uses data groups and user roles to define what data 

you can see and what you can do when you see it. Data groups organize data 

such as digital slides into different groups that can be seen and used by different 
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users. User roles define the commands you can use and the elements of a 

Spectrum page you can see. 

What this means for ImageScope users is that when you open a remote image 

ImageScope may request that you log in so Spectrum can determine if you have 

the correct permissions to view the images you want to access. Type the same 

user name and password you use to log into Spectrum. 

This also means that you may be restricted in what you can do with a digital 

slide. If, for example, you have read‐only access to the data group that contains 

the digital slide you are viewing, you can use the ImageScope drawing tools to 

draw annotations but you won’t be able to save them. If you have questions 

about your user permissions, contact your Spectrum administrator for assistance. 

Some of the features of the Spectrum security system you should know about 

are: 

 To keep user information secure, user credentials are encrypted and are 

never passed in clear text between the components of the Spectrum 

system. 

 User credentials can time out, so if sufficient time has elapsed since you 

logged in, you may be asked to log in again. 

 Data groups and user permissions are defined in Spectrum by the 

administrator. 

Depending on how Spectrum is configured, you may be able to log in as Guest to 

see public images that do not require user authentication. 

Opening a Digital Slide on Spectrum 
Connection speeds 
may affect 
ImageScope 
performance when 
viewing remote 
images. For best 
viewing, we rec-
ommend a connec-
tion speed of 
100mbps or greater. 

You can either open a remote digital slide from the Spectrum web interface, or 

you can open it directly from within ImageScope: 

To open a digital slide from within Spectrum: 

1. Start Spectrum in your Internet browser. (See the Spectrum/Spectrum Plus 

Operator’s Guide for details.) 

2. Log into Spectrum. 

3. Use the Spectrum List commands to see the digital slides on your site or 

use the search feature to find the one you want. 
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4. Select the digital slide you want to use by selecting the check box next to 

it and clicking View Images: 

 

Or click on the image thumbnail. The digital slide opens in ImageScope. 

To open a Spectrum digital slide directly from within ImageScope: 

1. Go to the ImageScope File menu and select Access Remote Server to 

connect to Spectrum. Enter the name of the server on which Spectrum 

resides: 

 

2. Set the Port value to 82. 

3. Click Connect. 

4. When asked for your user name and password, enter your Spectrum 

user name and password. 
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5. Now you see a page of digital slides on the Spectrum site. You can 

choose between two views: List and Thumbnail by selecting the view 

you want from the drop‐down list at the upper right. 

 

6. Select a digital slide by clicking ImageScope beneath an image. 

Opening a Digital Slide on Your Workstation or LAN 
To open a digital slide that resides on your workstation or local area network: 

1. Start ImageScope by clicking Start, pointing to All Programs > 

ScanScope, and then selecting ImageScope. 

2. Go to the File menu and select Open Image (or click   on the 

ImageScope toolbar). 

3. On the Open Image window, navigate to the location that contains the 

image you want to view. 

4. Click the name of the digital slide you want to open and click Open. 
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You may need to change the file type in the Open Image window to see the type 

of image you want to view. For example, to view a CWS image, click the file type 

drop‐down list and select Composite WebSlides (*/SlideScan.ini). 
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Local Image Support 
If you open a local image instead of an image in Spectrum, the following 

ImageScope features are not supported for that image: 

 Smart sync 

 Tracking 

 IQ  

Opening a Recently Viewed Local Digital Slide 
ImageScope displays a list of the last few digital slides that were viewed on the 

File menu. 

1. Go to the File menu. 

2. Click on one of the digital slides listed at the bottom of the menu to open 

it. 

 

Opening and Viewing Multiple Digital Slides 
You can open multiple digital slides within ImageScope. To open multiple digital 

slides in Spectrum: 

1. Log into Spectrum. 

2. Use the Spectrum List command to see the digital slides on your site or 

use the search feature to find the ones you want. 
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3. Select the digital slides you want to use by selecting the check boxes next 

to them and clicking View Images: 
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The digital slides open in ImageScope: 

 

You can view all the slides at once or view them separately: 

 To view all slides side by side vertically (as in the example above) go to 

the ImageScope Window menu and select Tile Vertical. 

 To view all slides in a horizontal format, go to the ImageScope Window 

menu and select Tile Horizontal. 

 To view the slides one at a time, go to the ImageScope Window menu 

and select Cascade. Then click the Maximize button at the top of the 

slide you want to view, which causes it to fill the ImageScope window: 
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 When multiple digital slides are open but only one is displayed, to move 

between the opened images, click on the image you want to view in the 

ImageScope filmstrip in the left pane of the window.  

 

If the ImageScope filmstrip is not visible, go to the View menu and select 

Filmstrip.  

For details on how to move all images in step, see “Synchronizing Navigation of 

Multiple Digital Slides” on page 31. 

Managing Digital Slide Windows 
You can maximize, minimize/restore, or close the individual digital slide 

windows within the ImageScope main window by clicking the slide icon on the 

image’s menu bar: 
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The following menu appears from which you can select an action to perform on 

this digital slide window: 

 

The Keep Open Option 
It may be convenient to keep a digital slide open in ImageScope as a reference 

image while you open and close other images to view side by side with it.  

However, when you select one or more multiple images in Spectrum (by clicking 

the thumbnail or selecting multiple images and using the View Images 

command), any images already open in ImageScope are closed before displaying 

the new ones.  

You can use the ImageScope Keep Open option to keep a specific image in 

ImageScope open when you select and view new images in Spectrum. 

To keep an image open: 

1. With the image open in ImageScope (and selected if there are more than 

one images displayed), go to the Image menu and select Keep Open or 

type Control K. 

2. When you do want to close the image you have kept open, select the 

image, go to the ImageScope File menu and select Close Image or click 

the Close Image icon   on the toolbar. 

You can turn “keep open” on and off for the image by typing Control K or 

selecting the Keep Open command. To keep multiple images open, select each 

image in turn and type Control‐K. 
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Viewing Digital Slide Information 
To see information about the currently selected digital slide such as the image 

size, location, and compression ratio: 

1. Go to the Image menu and select Information or click   on the toolbar 

to see the Image Information window. 

 

ICC Profile gives the name of the ICC profile if one is being used. (See 

Appendix B, “Aperio Integrated Color Management” on page 193 for 

information on ICC profiles and color management.) 

Note that if this digital slide was scanned on a ScanScope, the timezone 

of the scan location and time of the scan are also displayed. The 

Information tab is always shown. The other tabs may not appear if those 

elements have not been associated with the digital slide. (For example, if 

a label image does not exist for this digital slide, you do not see the Label 

Image tab.) 
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For an Aperio Fused Image (AFI), the Information window contains 

information on the separate channel images that make up the AFI image: 

 

2. To see other information, click the: 

 Thumbnail tab to see a thumbnail image of this digital slide, the area 

of the glass slide that was scanned: 
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 Label Image tab to see the slide’s label: 

 

 Macro Image tab to see a macro camera image of the entire slide: 

 

Status Bar 
Information on the selected digital slide can also be seen in the status bar at the 

bottom of the ImageScope window. For example: 

 

The sample status bar above shows the following information: 

 73091 x 62821 = 12.8GB, file = 575MB – This means that the entire digital 

slide is 73,091 by 62,821 pixels in size. The digital slide’s raw data is 12.8 

gigabytes in size and the compressed size of the digital slide file is 575 

megabytes. 

 0, ‐12950 : 73091 x 62821 – The first two numbers indicate the pixel 

position of the top, left corner of the display. The second numbers 

indicate which part of the image is being viewed. 

 1815, 37033 – This indicates the current pixel position of your cursor. 

 Prefetching/progressive rendering – Indicates what performance 

options are in effect. For information on performance options such as 
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prefetching, interpolating, and progressive rendering, see “Performance 

Options” on page 183. 

 PAN – This shows what navigation or annotation tool is selected. In this 

case, panning is selected. 

You can turn the status bar off by going to the View menu and selecting Status 

Bar. (This command reverses the current state of the status bar display: if the 

status bar is showing, this command hides it; if it is hidden, this command shows 

it.) 

Saving and Opening an Image View 
An ImageScope view is the entire set of slide images that are open at one time in 

ImageScope.  

Saving an Image View 
If you have a group of digital slides that you want to view together, open them 

all in ImageScope and zoom and pan until you get the view you want. Then: 

1. Go to the File menu and select Save Image View(s). You are asked to 

save the file as a ScanScope Image Set .sis file: 

 

2. Type the name you want to use for the file and click Save. 
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Opening an Image View 
To open the image view you previously created: 

1. Go to the File menu and select Open Image to navigate on your 

network to the location of the .sis file you saved. You will need to select 

.sis from the Files of type drop‐down list to see the file. 

 

2. Select the .sis file you want to open and click Open. When ImageScope 

opens the .sis file, all digital slides that were in that image view will be 

open and in their former pan and zoom configuration. 

Closing Digital Slides 
To close a single digital slide: 

1. If you have multiple digital slides open, click the one you want to close 

in the filmstrip. If you only have one digital slide open, it is already 

selected. 

2. Go to the File menu and select Close Image.  

To close all digital slides: 

1. Go to the File menu and select Close All Images.  
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If you made any changes to the digital slide (for example, you added or changed 

an annotation), you are asked if you want to save the changes before you close 

the slide. 

 

Click: 

 Yes to save your changes  

 No to discard them, or  

 Cancel to leave the image open. 

You can configure ImageScope to always save annotations when you close an 

image without asking you for confirmation. See “Automatically Saving 

Annotations” on page 181 for instructions. 

For More Information 
 For a quick reference list of the ImageScope toolbar icons, see 

“ImageScope Toolbar Quick Reference” on page 29. 

 To navigate and change magnification settings on a digital slide, see 

Chapter 4, “Viewing a Digital Slide,” on page 27. 

 To adjust image color and brightness, see Chapter 6, “Making Image 

Adjustments,” on page 47. 

 To annotate a digital slide, see Chapter 9, “Annotating Digital Slides,” on 

page 75. 

 To save a snapshot of a digital slide you have modified or to save a 

portion of a digital slide, see Chapter 13, “Saving Digital Slides and 

Regions,” on page 109. 
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4 
Viewing a Digital Slide 

This chapter introduces you to using ImageScope by giving 
a tour of the ImageScope main window and showing you 
how to use the navigation and magnification tools. 

The ImageScope Viewing Window 

 

Throughout the rest of this guide, we will discuss these elements of the 

ImageScope viewing window. 

 Toolbar – Many of the ImageScope commands and features are available 

on the toolbar. You can also access many of these features through the 

ImageScope menus. See the next section for a quick reference list of the 

ImageScope toolbar icons. 

 Zoom slider – You can magnify or shrink the current view. See “Using 

the Zoom Slider” on page 37 for details. 

 Filmstrip – The filmstrip shows what slides are open. You can move 

between digital slides by clicking the slide’s image in the filmstrip. 

 Label window – If an image of the slide label has been associated with 

the digital slide, you can see it in the slide label window. 
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 Thumbnail window –  Digital slides are large and often you see only a 

portion of one in the ImageScope main window. The thumbnail is a view 

of the complete digital slide. See ”Using the Thumbnail Window“ on 

page 33. 

 Magnifier window– Move this tool to the area you are interested in to 

see a magnified view. See “Using the Magnifier Window” on page 36. 

Hiding and Showing ImageScope Window Features  
To hide or show elements of the ImageScope window: 

ImageScope 
Element To turn on or off… 
Filmstrip Go to the View menu and select Filmstrip to show or hide the filmstrip. 

Thumbnail Go to the View menu and select Thumbnail or click  on the toolbar to show or 
hide the thumbnail window. 

Magnifier Go to the View menu and select Magnifier or click  on the toolbar to show or hide 
the magnifier window. 

Status Bar Go to the View menu and select Status Bar to show or hide the status bar. 

Slide Label Go to the View menu and select Label Image or click  on the toolbar to show or 
hide the slide label window. 

Zoom slider Go to the View menu and select Zoom Slider or click  on the toolbar to show or 
hide the zoom slider. 

These commands reverse the current state of the element display: if the element 

is showing, the command hides it; if it is hidden, this command shows it. 

Clinical Viewing Mode 
Because ImageScope is so feature rich, the standard toolbar contains many 

different icons. A simplified version is available that contains just the tools used 

in a clinical environment.  

 To see the clinical toolbar, go to the View menu and select View Clinical 

Toolbar. 

 

When clinical viewing mode is in effect, only the summary view of the 

Annotations window is available, to provide quick and easy digital slide 

analysis*. 

 To see the full toolbar, go to the View menu and select View Standard 

Toolbar. 
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Adjusting the ImageScope Window 
To adjust the ImageScope window to the size you prefer, grab the boundary of 

the window and drag it in or out.  

You can maximize, minimize/restore, or close either the main ImageScope 

window or the individual digital slide window by using the appropriate 

controls: 

 

 The controls on the right are standard Windows controls that allow you 

to minimize, maximize, restore, or close the window. 

 The icons on the left perform the same functions by displaying a menu 

from which you can select the action to perform.  

ImageScope Toolbar Quick Reference 
Following chapters discuss using ImageScope features in detail—here is a quick 

list of the toolbar icons and what they do. 

*These icons are shown in clinical viewing mode. 

Icon Action 

 
Go to the Open Image window where you can browse for a local digital slide to 
open for viewing. 

 
Close the digital slide that is currently being viewed in ImageScope. 

 
Create a snapshot image of the digital slide currently being viewed. 

 
Save an ImageScope view, the entire set of digital slides that is currently open 
in ImageScope, as a .sis file.  

 
Go to the Image Adjustment window where you can make color and other 
adjustments to the digital slide currently being viewed. 

 
Go to the Image Information window which displays information about the 
digital slide currently being viewed. 

 
Go to previous view of the digital slide. 

 
Go to the next view of the digital slide (only enabled if you first used the back 
arrow icon to go to a previous view). 

 
*Manually synchronize navigation for all digital slides currently being viewed. 
(Used when multiple digital slides are open in the ImageScope window.) 

 

*Use smart synchronization for multiple digital slides being viewed. 
Corresponding regions in the digital slide images are synchronized. (Same 
icon as for manual synchronization, but colored yellow.) 

 
Show or hide the magnifier window. 

 
Show or hide the digital slide label window. 
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Icon Action 

 
Show or hide the thumbnail window. 

 
Show or hide the zoom slider. 

 
Display on the full monitor screen. (Or turn off if already in full-screen mode.) 

 
Show or hide axes or axes and grid. 

 
*Open the Annotations window where you can create multiple annotation 
layers and organize and add descriptions to annotations. 

 
Open the Annotation Link Manager window where you can link annotations or 
digital slides to create a viewing sequence. 

 
Go to the previous link (if a previous link exists). 

 
Go to the next link (if a next link exists). 

 
Pan the digital slide. 

 
Enable/disable Integrated Color Management. Only useful if the image 
contains an embedded ICC profile. 

 
*Turn Image Quality (IQ) mode on or off. 

 
Zoom the selected area of the digital slide. 

 
*Extract a region of a digital slide. 

 
*Draw a free-form annotation. 

 
Draw a free-form annotation to be excluded from analysis*. (This creates a 
negative annotation.) 

 
*Measure an object on a digital slide. 

 
*Draw a rectangular region (or a square if you hold down the Shift key while 
you draw). 

 
Draw an elliptical annotation (or a circle if you hold down the Shift key while  
you draw). 

 
*Draw an arrow pointing to an area of interest. 

 

*Select an image for a report. This feature is only useful if you have Spectrum 
Plus Reporting option installed and the report template you are using uses 
images. 

 
*See help information for ImageScope. 
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Full Screen Viewing 
To view the digital slide with the maximum viewing area, switch to full screen 

viewing: 

1. Go to the View menu and select Full Screen or click   on the 

ImageScope toolbar. The menu bar does not appear in this mode. 

To switch back to regular viewing mode: 

1. Click   on the ImageScope toolbar. 

Synchronizing Navigation of Multiple Digital Slides 
In some cases you may want all of the open slides to show the same navigation 

behavior when you are viewing them side by side. (For example, if you pan right 

in one slide, you may want every other digital slide to also pan right.) To 

synchronize navigation when multiple slides are open: 

On the ImageScope toolbar click  . Now when you navigate around one of the 

digital slides, the others move in step. 

Smart Synchronization 
Smart synchronization is an extension of the manual synchronization feature 

discussed above. Smart 
synchronization is 
able to compensate 
for rotation (non-
flipped) but not for 
other factors such as 
stretched or missing 
tissue. In those 
cases, ImageScope 
will do its best to 
display the same 
tissue feature in all 
tiled images, but not 
necessarily in 
exactly the same 
location. 

Click the   smart synchronization icon on the ImageScope toolbar to use smart 

synchronization. (Notice that the smart synchronization icon is the same as the 

manual synchronization icon except that it is colored yellow.) Smart 

synchronization differs from manual synchronization—not only is navigation 

synchronized between the slides, but corresponding regions in the digital slide 

images are also synchronized. 
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A common use of this feature is when you have multiple digital slides scanned 

from microscope slides that were all prepared from the same tissue block but 

that are stained differently. For example, below are two images of slides made 

from the same block; with smart synchronization enabled, the main features of 

the slide stay locked in step as the operator moves through the slides.  

 

Although smart synchronization is able to compensate for most of the rotation 

orientations made with the ImageScope rotation tool, it cannot compensate for 

“flipped” images, where you have used the rotation tool to flip the image 

vertically or horizontally on its axis; if you try to use smart synchronization on 

such images or try to “flip” images when smart synchronization is in effect, the 

following message appears: 
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Moving the Viewing Area 
ImageScope offers many different options for moving around a digital slide. 

Panning 
The simplest method for moving the viewing area is to pan the image: 

1. Click and hold the mouse button down while you drag the cursor across 

the digital slide. Your cursor turns into a closed fist  . Panning moves 

the slide in the direction you are dragging, allowing you to see more of 

the slide. 

Panning Tips 

 If you can’t pan the image, you may have an annotation tool selected. 

Click the   icon on the ImageScope toolbar and try again. 

 As you pan, the black rectangle in the thumbnail image also moves to 

indicate the section of the slide you are viewing. 

 If you want to set ImageScope to pan in reverse (called “pathologist 

mode”), see “Panning Options” on page 179. 

Autopanning 
You can use autopanning to move at high speed over a digital slide: 

1. Move the cursor to the center of the main viewing area. 

2. If your mouse has a scroll wheel, click it to start autopanning or right‐

click and select Autopan from the context menu. 

A small navigation icon appears:  , and you also see a darker version 

showing your cursor position:  . 

3. By moving the mouse in any direction, you can automatically pan in that 

direction very quickly. To stop autopanning, click any mouse button. 

Scrolling 
You can scroll across a digital slide to the right, left, up, or down. As you move 

your cursor toward the edge of the ImageScope main window, the cursor 

changes to an arrow:  ; click and hold the mouse button down to scroll in that 

direction. To stop scrolling, release the mouse button.  

Using the Thumbnail Window 
Depending on the magnification in use, the main ImageScope window may show 

only a portion of the slide. The thumbnail window shows the entire digital slide. 

The portion of the digital slide being displayed in the main window is enclosed 

in a black rectangle in the thumbnail window.  

ImageScope User’s Guide 33 
Purdue University is an equal access/equal opportunity/affirmative action university. 

If you have trouble accessing this document because of a disability, please contact PVM Web Communications at vetwebteam@purdue.edu. 



 Chapter 4 – Viewing a Digital Slide 

 

Click in the thumbnail window to move the main image to that part of the slide 

or drag the rectangle in the thumbnail window to move to another area of the 

digital slide.  

 

Re-sizing the Thumbnail Window 
You can change the size of the thumbnail by moving your cursor on the lower 

left corner of the thumbnail until you see a double‐ended arrow—then click and 

drag the corner in or out. 
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Using the Filmstrip 
As discussed in Chapter 3, “Opening a Digital Slide,” you can open multiple 

digital slides. 

1. To move between multiple digital slides in ImageScope, click the image 

of the one you want to see in the filmstrip in the left pane of the window. 

For example: 

 

Page Panning 
Use the keyboard arrow keys to move an entire screen‐page at a time: 

 Shift+Right‐arrow – Move a page to the right 

 Shift+Left‐arrow – Move a page to the left 

 Shift+Up‐arrow – Move a page up 

 Shift+Down‐arrow – Move a page down 
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Moving to a Specific Point 
To move to a specific spot on the digital slide: 

1. Go to the Image menu and select Go To. 

 

2. On the GoTo window, do one of the following: 

 Using the size of the image shown in pixels as a guide, type an X 

coordinate to select a point that is that number of pixels from the left 

edge of the image and a Y coordinate to select a point that is that 

number of pixels from the top of the image. 

 Click Go To: Center to position the point selected by those 

coordinates in the center of the current view. 

 Click Go To: Corner to position the point selected by those 

coordinates in the upper left corner of the current view. 

3. Click Close to exit the GoTo window. 

Using the Magnifier Window 
Use the magnifier window to show a larger view of a particular portion of the 

digital slide.  

Tips: 

 Drag the magnifier window on the main window to the area you want to 

see in more detail. Or simply leave the magnifier window stationary and 

move the cursor on the main image to the area you want to see in more 

detail, and the area at the current cursor location will appear magnified 

in the magnifier window. 

 You can resize the magnifier window by dragging its lower right corner. 

 The magnifier window’s default magnification is twice the resolution of 

the image in the main window. So if the main window is at 20x 

magnification, the magnifier window shows 40x. You can change  the 

resolution of the magnifier window by going to the Tools menu and 

selecting Options. For details, see “Magnification“ on page 174. 
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Changing Viewing Magnification 
In addition to using the magnifier window to show a portion of the digital slide 

in greater resolution, you can also change the resolution of the entire main 

window image. 

Immediate Maximum Zoom 
Double‐clicking on the image in the main window immediately zooms that 

image to the maximum magnification. Double‐click again to return to the most 

recently used magnification that was not the maximum magnification. 

Using the Zoom Slider 
You can adjust the magnification of the entire display by using the zoom slider. 

 

 Click Fit to set the magnification to 0x and fit the entire 

digital slide within the main viewing area. 

 Click any other magnification setting to zoom in using that 

magnification. 

 Click the slider and drag it up or down to change the 

magnification in small increments. 

 If your mouse has a scroll wheel, click the image in the main 

window and roll the scroll wheel to move the slider. 

 

For example, below we used the slider to select a magnification of 16.2: 
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To set magnification to percentages instead of 2x, 4x, and so on: 

1. Go to the Tools menu and select Options. 

2. Clear the Use “X” magnification rather than “%” check box and click 

OK. Now when you use the Zoom slider, it displays magnification 

percentages: 

 

To turn the zoom slider on or off, click   on the toolbar or go to the View menu 

and select Zoom Slider. 

Zoom Keyboard Shortcuts 
Instead of using the Zoom slider, you can hold down the Control key and press: 

 – key to zoom out  

 + key to zoom in 

Zoom Navigation 
To zoom into a particular area of the digital slide: 

1. Click   on the ImageScope toolbar. 

2. Click in the main image window at the upper‐left corner of the area you 

want to zoom into and, holding the mouse button down, draw a 

rectangle around the area you want to zoom into. 

3. Let go of the mouse button and the main window will be zoomed to that 

area.  

If you have already predefined a fixed size (see “Fixed Size Annotations” on 

page 180), to set the zoom rectangle to the predefined size, hold down the 

Control key while you click on the area you want to zoom into. 

Viewing with Color Management 
Aperio Integrated Color Management takes into account the optical 

characteristics of your ScanScope scanner and your display monitor to make sure 

that colors of the digital slides are displayed accurately. For information on 

Aperio Integrated Color Management, see Appendix B, “Aperio Integrated Color 

Management” on page 193.) 
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By default, ImageScope uses the ScanScope source ICC profile embedded in the 

digital slide and the target ICC profile for your monitor to make sure the image 

displays in accurate color. (The ICC profile is embedded in the digital slide 

image during scanning.) 

The ImageScope toolbar allows you to turn Integrated Color Management on or 

off: 

 Click the   icon on the ImageScope toolbar to turn color management 

on or off. If color management is enabled, the icon looks like this:  ; if it 

is disabled, it looks like this:  .  

 If an image has an embedded ICC profile, you see the   symbol at the 

bottom of the image. If color management is turned off, the symbol on 

the image looks like this:  . 

For example, in the illustration below, color management is enabled. The image 

on the left does not have an embedded ICC profile, and the image on the right 

has an embedded ICC profile: 
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Viewing Scale Axes and Grid 
You can view scale axes and a grid on an image in ImageScope. The units and 

spacing are adjusted to correspond to the resolution of the image and the current 

zoom level.  

The zero point of the axes is in the center of the window; it is labeled with the 

current unit (for example, um for microns in the example below). If the 

resolution of the image is unknown, the units on the axes/grid will be p (pixels), 

kp (kilopixels), or mp (megapixels). This would be the case for 

photomicrographs and gross images before the resolution is set. The resolution 

on such images can be entered explicitly or by measuring a known item with a 

ruler (see Chapter 8 “Image Resolution” on page 71). 

To enable the axes view: 

1. Click   on the ImageScope toolbar or go to the View menu and select 

Scale Axes/Grid. The view in the main window appears with axes 

markers: 

 

2. Click the down arrow next to the   icon to select whether you want to 

see just the axes or the axes plus a grid: 
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The image with the scale axes and grid looks like this: 

 

Note that the icon on the toolbar changes to reflect the fact that the grid 

is displayed:  

 instead of  . 

3. To turn the axes/grid off, click the axes/grid icon or go to the View menu 

and select Scale Axes/Grid. 

Viewing Digital Slides with IQ 
Aperio Image Quality (IQ) technology gives pathologists and other scientists 

who view digital slides the ability to customize the view of those slides to boost 

productivity and visual clarity by digitally adjusting the stain colors, viewing the 

individual stain images, and/or re‐mixing the stains on the fly while they 

navigate the image. 

IQ allows you to choose for yourself what view of the digital slide gives you the 

best results and makes it easier for you to identify the features of the slide you 

are most interested in. 

IQ is available when you have opened a digital slide in ImageScope from 

Spectrum and if your site is licensed for Spectrum Plus. 
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IQ Features 
IQ uses color processing—analyzing each pixel of the digital slide image—to 

identify stains and modify their appearance on the digital slide. Some of its 

features include the ability to: 

 View just a selected stain as you navigate the digital slide. IQ uses color 

deconvolution to separate the stains and present them as you pan or 

scroll about the image.  

 Boost or dilute the displayed concentration (especially useful for 

overstained or understained slides, or to suit your personal preference). 

 Enhance cellular detail such as nuclei. 

 Digitally adjust individual stain colors for visual clarity and personal 

preferences (for example, darker/lighter, more or less vibrant, 

bluer/redder, and so on). 

IQ Quick Reference 
To turn IQ on for the image in the ImageScope window, click   on the toolbar. 

You can then select the stain set to use to view this digital slide by clicking the 

down‐arrow next to the   icon: 

 

The default stain set is optimized for Hematoxylin and Eosin stains. 

To use the IQ viewing toolbar and application: 

1. With IQ turned on, go to the Image menu and select Quality. You see the 

IQ viewing toolbar: 

 

2. Click the buttons to view the digital slide using all stains or individual 

stains. 
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3. To see the full IQ user interface, click the Details button on the viewing 

toolbar: 

 

Now you can use the IQ tabs to define the stains applied to the digital slide, re‐

mix and re‐color those stains, create your own stain sets, and measure the stains 

used by your lab. To return to just the viewing toolbar, click View Only. 

For details on using IQ, see the IQ Image Quality User’s Guide. 
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* Aperio’s image analysis algorithms are FDA cleared for specific clinical application, and are 
intended for research use for other applications. 
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5 
Rotating Images and Slide 

Labels 

ImageScope rotation tools allow you to rotate an image. You 
can also rotate a digital slide label image. 

Rotating an Image 
The rotation setting is in effect only for the current viewing session and is not 

saved with the image. However, when you create a new image by using the 

Snapshot or Extract Region commands, the new image will be saved in the 

current rotation. Saving an Image View also saves the current rotation settings so 

that opening the Image View displays the image with those rotation settings re‐

applied. 

Image rotation is not enabled during a TelePath Live* session. 

To use image rotation: 

1. Go to the ImageScope Image menu and select Rotate Image (Control E). 

A new toolbar appears: 
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2. From the rotation toolbar, select the rotation setting you want to use: 

 

Rotate 
Tool 

Description 

 
Rotate zero degrees 

 
Rotate 90 degrees right 

 
Rotate 180 degrees 

 
Rotate 90 degrees left 

 
Flip vertically 

 
Rotate 90 degrees right and flip vertically 

 
Flip horizontally 

 
Rotate 90 degrees left and flip vertically 

Label Rotation 
You can rotate a digital slide label. Open a digital slide in ImageScope and 

position the cursor on one edge of the slide label. A small arrow appears:  

 

Double‐click an arrow on the side of the label you want on top. When you save 

the digital slide, the label rotation is saved. 

                                                           

* This application is not approved or cleared by the FDA for clinical use. 
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6 
Making Image Adjustments 

It can be useful to modify the color settings of digital slides 
if particular colors do not show up well on your workstation 
monitor. This chapter discusses the different image 
adjustment settings. 

Image adjustments apply only to the current ImageScope session. They are not 

stored with the digital slide (so you don’t have to worry that you have modified 

your original digital slide when making an image adjustment). You can save 

gamma settings to apply to the current digital slide or to apply to other digital 

slides later, and you can make a snapshot of the adjusted image if you want to 

save the adjusted digital slide image. (See Chapter 13, “Saving Digital Slides and 

Regions” on page 109 for information on making snapshots.) 

For information on 
adjusting 
fluorescence images, 
see Chapter 7, 
“Working with 
Fluorescence Digital 
Slides.” 

Use the image adjustment feature to: 

 Adjust the brightness or contrast for all colors or for just the red, green, 

or blue channel. 

 Modify the color balance (for example, make reds less red and more 

cyan). 

 Adjust color curves for all colors or for just the red, green, or blue 

channel. 

 Save the color adjustments you have made in a gamma table file so they 

can be re‐applied to the same or other digital slides in future ImageScope 

sessions. 

 Make image adjustments to the entire digital slide or to Z‐stack* images.  
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Getting Started with Image Adjustments 
To make image adjustments: 

1. Go to the Image menu and select Adjustments or click   on the 

ImageScope toolbar. The Image Adjustments window appears: 

 

General Tips 
 To modify the appearance of the entire digital slide, select Main Image; 

to modify just the current Z‐stack* images, select Z‐stack Images. (For 

information on 3‐dimensional Z‐stack images, see Chapter 17, “TelePath 

Live*,” on page 155.) 

 Click and hold the Compare button to temporarily change the image 

back to the original settings; release the button to revert back to the 

changed settings.  

 Click the Reset button to change all colors back to the original default 

settings. 
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Modifying Brightness and Contrast 
To modify brightness and contrast: 

1. On the Image Adjustments window, click the Brightness/Contrast tab. 

 

2. Select a colored square to adjust the brightness or contrast for a 

particular color channel: 

 Gray – All color channels 

 Red – Just the red channel 

 Green – Just the green channel 

 Blue – Just the blue channel  

3. Click, hold, and drag the slider bars to adjust the brightness or contrast. 

Drag to the left to decrease brightness or contrast; drag to the right to 

increase brightness or contrast. Or type a number in the Brightness or 

Contrast box—a negative number to decrease brightness or contrast or a 

positive number to increase it. 

4. When all color settings have been adjusted, click OK. 
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Modifying Color Balance 
To adjust the color balance: 

1. On the Image Adjustments window, click the Color Balance tab. The 

following Image Adjustment window appears: 

 

2. Click, hold, and drag the sliders to adjust the color balance in the red, 

green, and blue channels. Or type a number in the color boxes—a 

negative number to move the balance to the left or a positive number to 

move it to the right. 

3. Select the Keep brightness constant check box to keep the overall 

brightness constant. When this is selected, as one channel’s intensity is 

adjusted, the other channels’ intensities are adjusted to balance the 

overall brightness. If you want to adjust the intensity of each color 

independently of the other channels, unselect this check box. 

4. When all color settings have been adjusted, click OK. 
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Modifying Color Curves 
To adjust the color curves: 

1. On the Image Adjustments window, click the Color Curves tab. The 

following Image Adjustment window appears: 

 

2. Select a colored square to adjust the brightness or contrast for a color 

channel: 

 Gray – All color channels 

 Red – Just the red channel 

 Green – Just the green channel 

 Blue – Just the blue channel  

ImageScope User’s Guide 51 
Purdue University is an equal access/equal opportunity/affirmative action university. 

If you have trouble accessing this document because of a disability, please contact PVM Web Communications at vetwebteam@purdue.edu. 



 Chapter 6 – Making Image Adjustments 

 

3. Select either the pencil tool,  , or the points tool,  .  

a) The pencil tool allows you to draw a free‐form shape across the 

graph to define the color curve.  

b) The points tool allows you to edit the color curve by creating and 

dragging points that define the curve.  

In the example below, we selected the red channel, selected the points 

tool, clicked on the curve to create a point, and then dragged the point 

down to change the red channel curve. The In and Out boxes indicate the 

current cursor position on the curve. 

 

4. When you have adjusted all color curves, click OK. 
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Saving and Loading Color Settings 
You can save all of the image adjustments you made on the other Image 

Adjustments window tabs by saving them on the Load/Save tab. You can also 

apply settings you previously saved to the current image by loading them. 

1. On the Image Adjustments window, click the Load/Save tab. The 

following window appears: 

 

For information on 
loading a default 
gamma table file to 
be used every time 
ImageScope opens a 
digital slide, see 
“Default Gamma 
Files” in the chapter 
“ImageScope 
Options.” 

Saving Color Adjustment Settings 
To save the current color adjustment settings: 

1. Click Save.  

2. On the Save Gamma Tables window, navigate to the directory in which 

you want to save the gamma table file and type a file name. 

3. Click Save. 

4. Click OK to exit the Image Adjustments window. 
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Loading Color Adjustment Settings 
To load previous settings 

1. Click Load.  

2. On the Load Gamma Tables window, navigate to the location of a 

previously saved gamma table file. 

3. Select a file. 

4. Click Open. 

5. Click OK to exit the Image Adjustments window. 

For More Information 
 For information on Z‐stacks, see Chapter 17, “TelePath Live*” on page 

155. 

 For information on loading color settings to be used every time 

ImageScope opens, see “Default Gamma Files” on page 175. 

                                                           

* This application is not approved or cleared by the FDA for clinical use. 
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7 
Working with Fluorescence 

Digital Slides 

This chapter discusses how to view and adjust fluorescence 
digital slide images. 

Images from the ScanScope FL are grayscale images, pseudo‐colored during the 

scanning process. 

ImageScope offers a full range of fluorescence features: 

 Temporarily apply a false color to a fluorescence image (this is not 

needed for fluorescence digital slides created by the ScanScope FL) 

 For a fused image: 

 Change the display color for each channel image 

 Adjust brightness, contrast, and gamma (viewing the results on the 

image and on a histogram display) 

 Adjust registration between channels 

 Fuse multiple fluorescence channel images into a fused image 

(automatically done for images acquired with the ScanScope FL) 

Applying a Temporary False Color 
If you are using a grayscale fluorescence image and want to display it in color: 

1. Open the image in ImageScope. 

2. Go to the Image menu and select False Color. The False Color window 

appears: 

 

3. Select a color by clicking a color box or using the color slider.  
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4. Select the Enable check box to see the image in the color you have 

selected. To view the image without the false color, clear the Enable 

check box. 

Applying a false color in this way does not permanently change the display color 

for the image—this adjustment applies only to the current ImageScope viewing 

session.  

Adjusting Fluorescence Fused Images 
Fluorescence images are displayed in ImageScope using the color, brightness, 

contrast, and registration settings made in the ScanScope Console when the scan 

was made.  

Any changes you make on the Image Fusion Adjustments window are saved 

with the image so that they apply the next time you open the image in 

ImageScope. 
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To use the Image Fusion Adjustments window: 

1. Open an Aperio Fused Image (AFI) in ImageScope. The usual way you 

will do this is: 

a) Log into Spectrum. 

b) Go to the Digital Slides menu and select All Digital Slides (As List).  

c) Select the AFI and click View Images to open the image in 

ImageScope: 

 

The AFI is indicated by the   symbol. 
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2. Go to the ImageScope Image menu and select Fusion Adjustments (only 

available if viewing an AFI). You see the Image Fusion Adjustments 

window: 

 

At the top is listed the fused image—beneath that are the individual 

channels that make up that image. 

Using the Fusion Adjustment Window 
You can enable features by clicking the symbols at the bottom of the Image 

Fusion Adjustments window (see the following sections for details on using each 

of these tools): 

Tool Function 

 
If at least one channel is hidden, this button cycles between the 
channels, showing different combinations. 

 Show/hide color pane. 

 Show/hide brightness, contrast, gamma adjustment pane. 

 
Show/hide registration pane. 

On each secondary pane, click   to reset the image to the original image settings 

(at the time the image was scanned). If the fused image is selected, this button 

resets all channels.  
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Before using one of the options at the bottom of the window, click a channel to 

select it so that the changes you make apply to that channel image. In this 

example, Cy5 is selected. 

 

After opening a tool pane, click   to close the pane to exit back to the main 

Image Fusion Adjustments window. 

Hiding a Channel 
To hide a channel, click the eye symbol:   next to it. (To add it back to the 

display, click the eye again.) 

 

Notice the difference in the image with the Cy5 channel hidden (on the right). 
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Hiding a Channel Color 
Click  the color box next  to a channel  to  turn off  the  false color for  that channel 

(that is, to display it in grayscale). To turn the false color back on, click the color 

box again.  

 

Notice the difference in the image with the Cy5 channel displayed in grayscale 

(on the right). 

Hiding All Color 
To remove all color, click the color box next to the AFI: 

 

Seeing Channel Information 
Place the cursor on a color box to see information about that channel. 
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Cycling Channel Displays 
To cycle the display among the channels: 

1. Hide a channel by clicking the eye symbol:   next to it.  

2. Click the   button to cycle among different combinations of channels.  

For example, below we have hidden the Cy5 channel (this also automatically 

turns off the AFI fused image as all channels must be on to see the fused image): 

 

Now we click the   button to cycle the display to a new combination of 

channels (DAPI and Cy5). 
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Clicking this button again cycles the display to another combination of channels. 

To turn off cycling, manually turn on all channels by clicking the   next to 

hidden channels. 

Adjusting Color 

To change false colors, on the Image Fusion Adjustments window, click  . On 

the color adjustment window, select a channel and select the color to be used to 

display that channel by clicking a color box on the Color Adjustment pane or 

using the color slider. 

 

Click   to invert color intensity in the display—the brightest pixels in the 

selected color become dark and the darkest pixels become bright. If a channel has 

been inverted, a small inversion symbol appears next to the color box for the 

channel. 

For example: 
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Adjusting Brightness, Contrast, and Gamma 

To adjust brightness, contrast, and gamma, click  . You may want to change 

these settings to eliminate background noise, boost a weak signal, assign a 

histogram stretch, and so on. These settings affect the display of the fused image 

and channel images, but do not affect the actual pixel data in the image files. 

 Brightness – This setting adjusts the overall intensity of every pixel. You 

may want to use this to brighten dark images or darken bright images. 

 Contrast – This setting makes the dark pixels darker and the light pixels 

lighter.  

 Gamma – This setting changes the midtones of your image. It is a 

nonlinear adjustment that can make faint objects more intense without 

saturating bright objects. At the same time, medium‐intensity objects can 

be made fainter without dimming the bright objects. 

A typical way of using these settings it to first adjust the contrast to stretch the 

intensity of the image and then, if the image is too bright or dark, adjust the 

gamma. 

The best way to see the effect of the settings is just to try them on your image to 

see what improves the image. 

 

Select a channel (or the fused image) and select the settings you want to use. You 

can make these changes with color turned on or off. Any adjustments you make 

are immediately visible in the image in the ImageScope window. 

 To see an intensity histogram of the current view of the image, click the 

 symbol. (See “The Intensity Histogram” below.) 

 To turn automatic contrast settings for the image thumbnail on or off, 

click   (“Th” stands for “thumbnail”). Automatic contrast for 
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thumbnails is on by default to boost contrast, as thumbnails tend to be 

very dark.  

If Auto Contrast is on, brightness, contrast, and gamma settings are not 

applied to the thumbnail; if it is off, they are.  

If this setting is not beneficial to the visual quality of your particular 

image, turn it off. This setting is used not just by ImageScope, but also by 

Spectrum when displaying thumbnails, so turning it off in ImageScope 

also affects thumbnail display in Spectrum or any other Aperio 

application that displays thumbnail images. Once turned off, the setting 

stays off for this image until you turn it on again. 

 To compare the new settings against the original, click  . 

The Intensity Histogram 
To see a histogram of the current image view, click the   button.  

The histogram plots the number of pixels at each intensity. By looking at the left 

of the histogram you can see how many pixels are in the darkest intensity; the 

right of the histogram shows how many pixels are in the lightest intensity. 

The black line shows a transfer function that relates input to output. You might 

also know this line as the tone curve. In an unadjusted image, this line is a straight 

line from zero to maximum intensity. As you change settings, the line changes to 

reflect your adjustments. 

 

The Low Clip and High Clip sliders allow you to set thresholds. For example, 

the Low Clip slider sets a lower threshold point—if any pixels fall below that 

value they are forced to zero. This is often used to eliminate noise (the “noisy” 

pixels that do not convey real information are simply forced to black). The High 

Clip slider sets an upper threshold point—if any pixels fall above that value they 

are forced to the maximum value (white). 
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For example, in the image shown above, we adjust the gamma on the Cy3 

channel to darken the midtones: 

 

Now we move the Low Clip slider to eliminate noise in the lower intensities: 

 

Adjusting Registration 
Fluorescence images acquired on the ScanScope FL using the quad multi‐

bandpass filter cube should be perfectly registered. Images acquired using 

single‐bandpass filter cubes or images imported from other sources may require 

registration changes so that the channels are aligned correctly.  
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To see the registration pane, click   on the Image Fusion Adjustments window. 

 

Select the channel you want to register. (In the example above, Cy5 is selected.) 

 Use the arrows to move the image pixel by pixel in the X or Y axis. The 

arrows closest to the center of the arrow strip move the image by one 

pixel, the next arrows move it by 10, and the arrows at the end of the 

arrow strip move it by 100 pixels. 

 Click the 0 at the center of the arrow strip to move the image back to its 

original position on that axis. 

 The colored box in the middle of the display shows the position of the 

image relative to its original position. That is, the box starts in the center 

and moves as you use the arrows. The color of the border of the box tells 

you which channel you are working with. (In the example above, the red 

border is the same color used for the channel Cy5, so we know we are 

working with that channel.)  

 The movement of the image in the X/Y axes is shown in the X and Y 

boxes. 

Fusing Fluorescence Images 
The ScanScope creates a multi‐layer “fused” image made up of the individual 

channel images. However, you can also use ImageScope to create your own 

fused image or create one from individual channel images you received from 

another source. 

Our example shows opening images in Spectrum. 

1. Log into Spectrum and select All Digital Slides (As List) from the 

Digital Slides menu. 
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2. Select the check boxes next to the channel images you want to use to 

create a fused image and click View Images: 

   

ImageScope opens each of the selected images: 

 

In this example, we have three images, one for each type of fluorochrome 

used to stain the slide: Cy5, DAPI, and Cy3. 

If you want ImageScope to keep each of these images open after it 

creates the fused image, click the first image to select it, go to the Image 
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menu, and select Keep Open (or type Control K). Repeat for the other 

images. 

3. On the ImageScope menu bar, go to the Image menu and select Fuse 

Images. 

4. On the Remote Image List Box, select all channel images that make up 

the fluorescence scan: 

 

This window does not ask you for a file name or description if you 

opened the images directly from your local workstation or network 

location as ImageScope automatically assigns a file name based on the 

base file name of the channels when working with local images. 

5. Type a file name to use for the AFI file and, optionally, a description. 

If the channel images belong to more than one digital slide, this window 

asks you to choose which digital slide to add the fused image to.  
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6. Click Fuse Selected Images. This creates an AFI. ImageScope opens the 

AFI and displays it in the main window: 

 

When you close ImageScope and return to Spectrum, you see the AFI 

listed in the digital slide list: 

The AFI is indicated by the   symbol. 
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8 
Image Resolution 

This chapter discusses how to see the resolution of an 
image and, if it is not known, how to set it. 

For digital slides created by scanning microscope slides on a ScanScope scanner, 

the resolution of the image is known and is stored in the image file. 

The resolution may not be known for other types of images you are working 

with.  

It is useful to know the resolution of an image because the resolution is used to 

display the magnification in the zoom slider, to compute ruler values, and to 

compute the length and area of annotation regions.  

To view and set an image’s resolution: 

1. Go to the Image menu and select Resolution. The Image Resolution 

window appears: 
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If the resolution of the image is stored within the image file, Current 

Image Resolution and Apparent Magnification will contain values—if 

the resolution is not known, these boxes will be empty. 

Setting or Changing Image Resolution 
You can use the options on this window to change or set the image resolution: 

 Use Resolution Specified in Image File – If the resolution is stored in 

the image file (for example, it was created by scanning a glass slide on a 

ScanScope scanner), select this option to reset the resolution to the value 

stored in the file. 

 Manually Enter Image Resolution (or Magnification) – If you know the 

resolution for the image, select this option and type the image resolution 

and apparent magnification values in the boxes at the top of the window. 

 Compute from Currently Selected Annotation Ruler – You can 

determine the resolution of the image from an object of known size in the 

scanned image. See the next section. 

Computing the Resolution from the Image 
If you select the Compute from Currently Selected Annotation Ruler option in 

the Image Resolution window, you can use an object of known size in the image 

to calibrate the image resolution. 

For example, in the following image a scale is part of the picture: 

 
Scale 

When you change 
the resolution, note 
that you only affect 
the way an image is 
viewed, but do not 
change the image 
file or information 
stored in it. 
 
Because the 
resolution is used to 
display the 
magnification in the 
zoom slider, to 
compute ruler 
values, and to 
compute the length 
and width of 
annotations, these 
values will all change 
when you change 
the resolution. 

1. Draw an annotation ruler across the scale, which in this case shows a 

length of 5 centimeters.  
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2. Go to the Image menu and select Resolution. The Image Resolution 

window now has a place for you to enter the length of the ruler: 

 

3. On the Image Resolution window, select Compute from Currently 

Selected Annotation Ruler and enter the length of the ruler in microns. 

In this case, enter a value of 50000 (5 cm = 50000 microns). If you want to 

delete the ruler after calibration, select the Delete Ruler after Resolution 

Computed check box. 

Now all values measured by rulers will be accurately calibrated to this scale, 

such as the second ruler shown above which measures a length of 31mm across 

the specimen. 
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9 
Annotating Digital Slides 

Annotations direct viewers’ attention to interesting 
elements of a digital slide. This chapter contains basic 
information on creating annotations. See the next chapter 
for advanced annotation information on moving and 
deleting annotations, using annotation layers to organize 
annotations, and storing algorithm analysis* results. 

Annotations can define a region of the digital slide you are interested in, measure 

an object, or point to an interesting area. You also use annotations to define the 

areas of a digital slide on which to perform an algorithm analysis* or to define the 

areas on which not to perform an analysis*. 

To add an annotation to a digital slide, use the drawing tools on the ImageScope 

toolbar: In the next chapter 
you will learn how to 
add text to an 
annotation so the 
text appears in the 
main window. To 
avoid having the text 
display on top of the 
annotation, when 
you create an 
annotation, finish 
drawing it at the 
upper right corner of 
the annotation. 

 Ellipsis (or circle if you hold down the Shift key while drawing) 

 Rectangle (or square if you hold down the Shift key while drawing) 

 Free‐form shape 

 Free‐form shape to exclude from analysis* (negative pen) 

 Arrow 

 Measurement 

 Select a Spectrum Plus report image 
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Note that you can also select these tools by right‐clicking on the ImageScope 

main window and selecting the tool from the context menu: 

 

Drawing Fixed Size Annotations 
If you have predefined a fixed size, to draw an annotation of that size, hold 

down the Control key while you draw the annotation. (This works with the 

rectangle, ellipse, arrow, report image, and ruler annotations.)  

See “Fixed Size Annotations” on page 180 and “Report Image Options” on page 

185 for information on setting a fixed size for annotations. 

Drawing Annotations with a Fixed Aspect Ratio 
Drawing an image in a specific aspect ratio (or capturing an image in a fixed 

aspect ratio) can be useful when preparing an image for a publication. 

To draw an image that uses the same aspect ratio as the fixed size you have 

defined for annotations, hold down both the Shift and the Control keys while 

you draw the annotation. For example, suppose you want to make sure all your 

annotations have a width/height ratio of 4:3. Specify a fixed annotation size of 

width of 400 pixels and height of 300 pixels. Then when you draw an annotation 

while holding down the Shift and Control keys, it will always have a ratio of 400 

to 300 (4:3), regardless of its size. 

You can also use the Shift and Control keys to extract a region of a specific aspect 

ratio. See “Extracting an Image of a Predefined Size or Aspect Ratio” on page 

114. 

To set a fixed size for annotations (and thus a fixed aspect ratio), see “Fixed Size 

Annotations” on page 180. 
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Free-form Drawing 
To draw a free‐form shape on a digital slide: 

1. Click   on the toolbar. 

2. Begin drawing in the main window by clicking and dragging. You see a 

colored line following the pen, as shown below. Release the pen when 

you have finished the shape. 

 

Measuring Objects 
Use the ruler tool to measure an object on the digital slide. 

The ruler tool may not work for all images you can view with ImageScope. 

Images that were not created by the ScanScope scanner may not have enough 

information included in them to allow the ruler tool to measure. (For instructions 

on setting resolution for images whose files do not contain resolution 

information, see Chapter 8, “Image Resolution,” on page 71.) 

1. Click   on the toolbar. 

2. Place your cursor on the object you want to measure in the main window 

and click while dragging the ruler over the object. Here is a sample 

display: 

 

The ruler automatically adjusts for the current display resolution. If you change 

magnification, the ruler stays in the same location relative to the image when you 

zoom. When you measure with the image displayed at lower magnifications, 
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such as 2x, the ruler displays in millimeters rather than microns as it is 

measuring something in a larger scale. 

Drawing an Arrow 
To draw an arrow to direct someone’s attention to an interesting feature of the 

digital slide: 

1. Click   on the toolbar. 

2. Place your cursor on the image in the main window close to the object 

you want to point at, and click and drag away from it. The further you 

drag, the larger the arrow appears. 

 

Drawing with the Negative Pen 
The negative pen tool is used to draw negative free‐form shapes. These are used 

in algorithm analysis* to designate areas not to analyze. 

To draw a negative shape on the digital slide: 

1. Click   on the toolbar. 
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2. Place your cursor on the image in the main window and begin drawing 

by clicking and dragging. Release the mouse button when you have 

finished. A negative region is indicated on the display by a dashed line. 

 

In this case, we used the rectangle tool to draw a boundary around the 

region we want to analyze, and used the negative pen to draw an area 

within the region that we want to exclude from the analysis. 

Selecting a Spectrum Plus Report Image 
ImageScope allows you to select a specific image from a digital slide or specimen 

to be used in a report that includes that image. (This feature is used by the 

optional Spectrum Plus Reporting product.) 

With a digital slide or specimen image open in ImageScope, click the   icon on 

the ImageScope toolbar and then click the area of the image that you want to 

appear in a report. The area selected is saved as an annotation with the text label 

“Report Image.” Only one report image can be selected for a single image, and 

the report template you are using must contain images in order for this image to 

appear. 

To draw an area of a fixed size, hold down the Control key while you draw. See 

“Report Image Options” on page 185 for information on setting the fixed size of a 

report image. 
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The report image appears on the image in the ImageScope window if 

you have annotation view enabled. As with all annotations, you can 

delete it or move it. 

 

Panning While Annotating 
If you need to draw an annotation that is larger than the current window in 

ImageScope, you can pan through the image while drawing, allowing you to 

draw the annotation on the entire image. Simply drag the annotation drawing 

tool—as you reach the edge of the image in the ImageScope window, the image 

will move in the direction you are moving your cursor to allow you to continue 

drawing.  

For More Information 
 See Chapter 10, “Using the Annotations Window,” on page 81 for 

information on other things you can do with annotations: 

 Add text to an annotation 

 Delete or move an annotation 

 Export or import annotations 

 Define annotation attributes to add information to an annotation. 

 For information on creating viewing sequences, see Chapter 11, “Linking 

Annotations and Digital Slides,” on page 99. 

 When analyzing* digital slides, you can use free‐form or rectangle 

annotations to define what areas to analyze or use the free‐form negative 

pen tool to define what areas not to analyze. See Chapter 14, “Analyzing 

Digital Slides,” on page 119 for details. 

 

                                                           

* Aperio's image analysis algorithms are FDA cleared for specific clinical applications, and 
are intended for research use for other applications. 
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10 
Using the Annotations Window 

Annotation layers are useful for organizing annotations and 
for storing algorithm analysis* results. The ImageScope 
Annotations window shows you the annotations associated 
with the image. 

ImageScope stores annotations in layers. You can use layers to organize 

annotations by reviewer or department so that each person’s or group’s 

annotations are on a different layer, and then: 

 Hide or show specific layers for different uses of the digital slide. 

 Delete only a specific annotation layer. 

Annotation layers are also where algorithm analysis* results are stored as 

quantitative data (see Chapter 14, “Analyzing Slides,” on page 119). 

Annotations made on different layers are drawn in different colors. See below for 

information on changing annotation layer colors. 

To open the Annotations window go to the View menu and select Annotations 

or type Control N. Now you can use the Annotations window in one of two 

modes: 

 Summary View – Designed for use with the Digital IHC product to 

provide one‐step annotation and analysis for IHC digital slides. 

However, this view can also be used for quick analysis of any type. 

 Detailed View – Complete details on all annotations are available and 

you can add annotation attributes, text labels, and so on. 

The Annotations Summary View Window – Quick IHC 
Analysis 
The ImageScope detailed Annotations window provides a general solution for 

image analysis* and handling annotations. However, a more streamlined version 

of the Annotations window is also available—the Annotations summary view. The 

Annotations summary view was specifically developed for analyzing* IHC 

digital slides and makes the process quicker and simpler by fitting into a 

pathologist’s or researcher’s normal workflow.  
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For details on using the Digital IHC features and on Digital IHC setup steps for 

Spectrum, see: 

 Digital IHC Userʹs Guide 

 Digital IHC Guide to Spectrum Setup 

 The userʹs guide for the specific IHC application you are using. 

Slide-Specific Processing 
The key to the Digital IHC workflow is slide‐specific processing, which defines how 

a digital slide will be processed based on its stain and type of tissue (body site). 

The slide‐specific processing can define what algorithm* will be used to analyze* 

that type of slide, how analysis results will be displayed and how to interpret 

those results (alternatively, manual scoring can be set up for the slide), and what 

comments will be available to be used by the pathologist or researcher viewing 

the slide. 

The slide‐specific configuration for each stain/body site combination is defined 

by the Spectrum administrator. See the Digital IHC Guide to Spectrum Setup for 

details. 

Once slide‐specific processing is set up, viewing, annotating, and analyzing* a 

digital slide becomes a quick process that takes just a few mouse clicks. 

The summary view of the Annotations window is designed specifically for 

working with IHC digital slides to provide a quick way to mark tumor regions 

and analyze* them in one simple step. 

Using the Annotations Summary View Window 
To open the Annotations window in summary view: 

1. Identify a digital slide in Spectrum for which stain/body site slide‐

specific processing has been defined. 
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2. From the Spectrum page, open the digital slide in ImageScope by 

clicking its thumbnail. The Annotations window in summary view 

appears. (If the window does not look like this, click the Summary 

button to return the Annotations window to the summary view): 

 

The algorithm* appropriate for this type of slide is listed in the drop‐down box. 

You can select another algorithm* if you wish from that box. Note that if you are 

in clinical viewing mode, the summary view Annotations window is the only 

view you can see. 

From this window you can draw annotations to identify areas to analyze* and 

run the analysis* all in one easy operation: 

1. With the algorithm* that you want to use shown in the drop‐down list, 

use the ImageScope pen or rectangle drawing tools to draw the areas of 

the digital slide you want to analyze*. 

2. To navigate between annotations you have drawn, use the numbered 

buttons or arrow keys. (As you draw annotations with the analysis 

algorithm* shown in the drop‐down box, the buttons at the top of the 

window display a number for each annotation.)  
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a) Click the numbered button that corresponds to the annotation you 

want to see. That annotation is centered on the ImageScope window. 

b) Move between the annotations by using the arrow keys. 

c) To delete the currently selected annotation click  . To delete all 

annotations, click  . 

d) To hide the selected annotation on the ImageScope window, click  . 

e) To save the annotations to Spectrum, click  . 

3. To analyze* the current digital slide with the algorithm* shown in the 

drop‐down box: 

a) Select the annotation drawn around the area you want to analyze* 

and select Selected Annotation. (Or, if you want to analyze* the 

entire area shown in the ImageScope window, select Current 

Screen.) 

b) Click Run Analysis. As the analysis* runs, you see progress 

information: 
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When the analysis* is complete, you see the results: 

 

For more information on using the Annotations summary view window, see the 

Digital IHC User’s Guide. 

Enabling/Disabling Pre-processing 
When using the Annotations window summary view, you may temporarily turn 

off pre‐processing region finding for algorithms that support that feature (for 

example, if you want to select possible tumor areas yourself to analyze rather 

than allowing the algorithm to do it for you). 

To disable pre‐processing, open the Annotations window in summary view and 

click the pre‐processing button: 

 
To turn pre‐processing on again, click the button again. Note that this button is 

only enabled when you are using an algorithm that supports pre‐processing. 
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Incremental Processing 
The IHC analysis applications are incremental algorithms, which means that as 

you add new regions and click Run Analysis on the Annotations window, only 

the new regions are analyzed, which can save a great deal of time. Any time you 

click Run Analysis again, all analysis results are updated. 

Incremental processing is useful when a pathologist draws a single region and 

analyzes it, and after reviewing the analysis results wants to select additional 

regions and analyze them as well. The pathologist can add more annotation 

regions as needed or delete annotation regions and the analysis results will be 

updated accordingly. 

If you delete a region, ImageScope will automatically re‐run the analysis to 

update the summary analysis results that included that region. However, adding 

regions may make the analysis results incorrect until you re‐run the analysis. 

Other Options 
 To see a report image you have selected, select Report Image from the 

drop‐down list. 

 To create an annotation that will not be used for analysis* (for example, a 

ruler or arrow), select Annotations from the drop‐down list before 

drawing. 

 If the algorithm you are using support result plots and they are enabled, 

the summary view window automatically opens all plots in separate 

windows when the analysis is done. 

The Annotations Detailed View Window 
To see information on the annotation layers attached to a digital slide and to 

work with those layers: 

1. Open the digital slide you want to work with.  

2. Go to the View menu and select Annotations.  

The following Annotations window shows a digital slide for which two layers 

have been created, “Dr. Bradley” and “Dr. Garcia”. (If the window does not look 

like this, click the Details button to return the Annotations window to the 

detailed view) 
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 The Layers pane on the left lists all defined layers for this digital slide. To 

select a layer to work with, click it in the list. See below for information 

on adding new layers, changing the annotation color for a layer, and 

deleting layers. 

 The Layer Attributes pane in the middle is where you can add and delete 

attributes for a layer. See below for more information. 

 The Layer Regions pane on the right is where you can add and delete 

attributes for an annotation. You can also select an annotation so you can 

delete or move it. See below for more information. 
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Here is a quick reference guide to the features of this window (we’ll talk more 

about these features later in this section): 

Icon Location Function 

 
Annotations window toolbar Arrange the Annotations window panes side by 

side, horizontally. 

 
Annotations window toolbar Arrange the Annotations window panes 

vertically. 

 
Annotations window toolbar Make Annotations window transparent so 

digital slide shows through. 

 
Layers pane Change the color of the annotations in the 

selected layer. (This box shows the current 
color for the layer annotations.) 

 
Layers pane Hide or show the annotations on the selected 

layer in the ImageScope main window. 

 Annotations window toolbar Save all annotations with the digital slide. 

 
Annotations window toolbar Import annotations from a previously exported 

annotation file. 

 
Annotations window toolbar Export the current annotations to an 

annotation file. Saved as XML with the same 
name as the digital slide file. 

 
Layer Attributes pane 
Layer Regions pane 

Export the contents of the pane to a text file. 

 
Layer Attributes Pane Display algorithm result plots. 

 
Layer Attributes pane 
Layer Regions pane 

Export the contents of the pane as an Excel 
spreadsheet. 

 

Layers pane 
Layer Attributes pane 
Layer Regions pane 

Add: 
New layer (if on the Layers pane) 
New layer attribute (if on the Layer Attributes 
pane) 
New annotation attribute (if on the Layer 
Regions pane) 

 

Layer Attributes pane 
Layer Regions pane 

Delete: 
Layer attribute (if on the Layer Attributes 
pane) 
Annotation attribute (if on the Layer Regions 
pane)  

 

Layers pane 
Layer Regions pane 

Delete: 
Selected layer (if on the Layers pane) 
Selected annotation (if on the Layer Regions 
pane) 

 Layers pane Delete all layers. 
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Configuring the Annotations Window 
There are several ways to configure the Annotations window to suit your 

preferences: 

 

 Click   to arrange the panes side by side, horizontally. 

 Click   to arrange the panes vertically. 

You can also: 

 Click the boundary between panes and drag it to expand or shrink the 

pane width. 

 Within a pane, click the line between columns and drag it to expand or 

shrink the column. 

 Drag any outside boundary of the Annotations window to expand or 

shrink the overall window. 

 Click the transparent button   to make the Annotations window 

transparent so the digital slide shows through it. 

Hiding or Showing Annotation Layers 
To make an entire layer visible or invisible on the ImageScope main window: 

1. Click a layer in the Layers pane to select it. 

2. Click  . (When this button is pressed down, the layer is visible; when it 

is raised, the layer is not visible). 
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Changing the Annotation Layer Color 
All annotations created in a layer are displayed in the same color.  

To change the default colors used for each layer: 

1. Go to the ImageScope Tools menu and select Options.  

2. Click the Annotations tab and click the color of the layer you want to 

change; a color selection window appears on which you can select the 

color you want to use. 

 

To change the color used for a specific layer: 

1. In the Annotations window, click a layer in the Layers pane to select it. 

2. Click   to open a color selection window from which you can select the 

color you want to use. All annotations in that layer immediately change 

to the new color. 
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Annotation Length and Area Display 
ImageScope measures and displays length and area for annotation regions. If the 

resolution of the image is known, length and area are displayed in microns; if 

not, they are displayed in pixels. 

 

Adding Text to an Annotation 
You can add a text note that will appear with an annotation on the ImageScope 

screen. The note will appear above and to the right of the point on the image 

where dragging stopped when the annotation was created. 

To add a text note: 

1. In the Layers pane, click the layer that contains the annotation for which 

you want to add a note. 

2. Click the annotation in the Layer Regions pane to which you want to add 

text. 

It is possible to draw 
an annotation in 
such a way that text 
defined for it 
appears on top of 
the annotation. To 
avoid this, when you 
create annotations 
finish drawing the 
annotation at the 
upper right corner of 
the annotation so 
that text will be 
added outside the 
annotation. 
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3. Type the note into the Text column. You can see the text note on the 

main window as well as in the Layer Regions pane of the Annotations 

window. 

 

Adding and Deleting an Annotation Layer 
To create a new layer in the current digital slide: 

1. Click   in the Layers pane.  

2. To change the name of the layer, click the name and type a new name. 

To delete a layer in the current digital slide: 

1. Click a layer in the Layers pane to select it. 

2. Click   to delete the selected layer. 

To delete all layers: 

1. Click   in the Layers pane to delete all layers. 

Deleting Annotations 
To delete an annotation either click it in the main ImageScope window to select it 

and then press the Delete key on your keyboard, or: 

1. Go to the View menu and select Annotations. 
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2. Select the layer in the Layers pane that contains the annotation you want 

to delete by clicking it. 

3. Then click the annotation in the Layer Regions pane that you want to 

delete to select it and click   in the Layer Regions pane to delete it. 

 

For example, to delete annotation 1 in the above example, we clicked Dr. Bradley 

in the Layers pane to select that layer, clicked 1 in the Layer Regions pane to 

select that annotation, and then clicked   in the Layer Regions pane to delete it. 

Note the blue bar in the example above, which indicates the annotation has been 

selected. 
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On the ImageScope main window: 

     

A selected 

annotation looks 

like this, with a 

dark line in the 

middle of the 

annotation 

boundary. 

An unselected 

annotation 

looks like this. 

 

Moving Annotations 
You can move a single annotation or all annotations.  

Moving a Single Annotation 
To move a single annotation: 

1. Click the annotation on the ImageScope window to select it. (See the 

section above for what a selected annotation looks like on the 

ImageScope main window.) 

2. While holding down the Control key, grab the selected annotation and 

drag it to a new location.  

Moving All Annotations at One Time 
There are occasions when you want to move all annotations at the same time. For 

example, if you import annotations from another, similar digital slide, slight 
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variations in the new slide might require adjusting the position of the imported 

annotations. To move all annotations at one time: 

On the ImageScope main window, while holding down the Control and Shift 

keys, drag an annotation to a new location—all other annotations will follow the 

motion of the one you are dragging. 

All annotations in all layers will be moved except for Z‐stacks† and markup 

images*. 

Saving Annotation Layer Changes 
To save any changes you made to the annotations, click  . 

Exporting and Importing Annotation Layers 
ImageScope provides several ways to export and import information and 

annotations. 

Algorithm analysis* results are stored in an annotation layer so you may want to 

export that information into a text file to include it in a report or to chart the 

information in a spreadsheet program. 

You can also export annotations to be used on other digital slides. For example, if 

working with several very similar digital slides, you may find the same 

annotations apply to all of them. 

Importing and Exporting Annotations 
To export all of the annotations for the current digital slide: 

 On the Layers pane, click  . You will be asked to specify a name and 

location for the .xml file created. 

To import an annotation file to the current digital slide: 

 On the Layers pane click  . You will be asked to navigate to the 

location of a previously exported annotations file. 

Exporting Text from Annotations Window Panes 
To export the text of the Layer Attributes pane to a text file: 

 On the Layer Attributes pane, click  . You will be asked to specify the 

name and location of the text file to be created. This text file is a tab‐

delimited file that can be imported into a spreadsheet program. 

To export the text of the Regions Attributes pane to a text file: 

 On the Regions Attributes pane, click  . You will be asked to specify 

the name and location of the text file to be created. This text file is a tab‐

delimited file that can be imported into a spreadsheet program. 
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Exporting Text from Annotations Window Panes to a Spreadsheet 
Numeric data exported from the Annotations window to a spreadsheet is 

exported as text. Excel shows a warning note for each of these cells that the 

numbers are in text format—when you click on the note you can select an option 

to transform the text to numeric format. 

To export the text of the Layer Attributes pane to a Microsoft Excel spreadsheet: 

 On the Layer Attributes pane, click  . You will be asked to specify the 

name and location of the spreadsheet .xls file to be created.  

To export the text of the Regions Attributes pane to a Microsoft Excel 

spreadsheet: 

 On the Regions Attributes pane, click  . You will be asked to specify 

the name and location of the spreadsheet .xls file to be created.  

Adding and Deleting Attributes 
Attributes are text fields that describe the layer or annotation. Several attributes 

are already defined. For example, the Layers pane and the Layer Regions pane 

both contain a Description attribute. By typing text in this column, you can 

include comments or a description of the layer or annotation.  

When multiple entries are defined for an attribute, you can sort the entries 

alphabetically by clicking the attribute title. In this example, we clicked Case# to 

sort the list of annotations by case number: 

 

Adding Your Own Attributes 
You can also add your own attributes (for example, slide routing information, 

test results, etc.). To add a new layer attribute: 

1. On the Layers pane, click a layer to select it. 
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2. On the Layer Attributes pane, click   to add a new attribute. You will 

be asked to enter the name of the attribute. The new attribute is the title 

for a new column that contains a text field in which you can enter any 

data you wish. 

 

To add a new annotation attribute: 

1. On the Layers pane, click a layer to select it. 

2. On the Layer Regions pane, click   to add a new attribute. You will be 

asked to enter the name of the attribute. The new attribute is the title for 

a new column containing a text field in which you can enter any data 

you wish. 

Deleting Attributes 
To delete a layer attribute: 

1. On the Layers pane, click a layer to select it. 

2. On the Layer Attributes pane, click an attribute to select it. 

3. Click   to delete the selected attribute. 

To delete an annotation attribute: 

1. On the Layers pane, click a layer to select it. 

2. On the Layer Regions pane, click an attribute to select it. 

3. Click   to delete the selected attribute. 
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* Aperio's image analysis algorithms are FDA cleared for specific clinical applications, and 
are intended for research use for other applications. 
† This application is not approved or cleared by the FDA for clinical use. 
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11 
Linking Annotations and 

Digital Slides 

Creating a viewing sequence by linking digital slides and/or 
annotated regions is a powerful way to organize and 
present information. 

Here are two sample uses of linking annotations and digital slides: 

 Create a path of views through a slide or group of slides that takes the 

viewer on a tour of highlighted features.  

 Create a hierarchy of images, perhaps from gross specimen down 

through blocks and then to slides. 

Links have the following characteristics: 

 Links can be associated with a region in a digital slide or with the entire 

image.  

 Links have direction. If you traverse a link in the forward direction, you 

can follow the same link back. 

 You can create any number of links into or out of a region or image. 

 If there is more than one link to or from the currently selected annotation 

or slide, then the Link Manager window will open so that you can select 

a link. 

 You cannot create links for layers, only for digital slides or annotations. 
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Working with the Link Manager 
To start the Link Manager, go to the View menu and select Annotation Links 

Manager. 

 

On the left side of the Link Manager window is a tree view of all digital slides 

that are open in ImageScope. The next level represents annotation layers, and the 

final level is annotations in that layer. For example, the first slide above, 

Ex3_40X.svs, contains two layers, “Dr. Bradley” and “Dr. Garcia.” The “Dr. 

Bradley” layer contains three annotations, “TB5/5/06,” “TB5/12/06,” and 

“TB5/12/06.” 

Click the + symbols to expand the lists, and the – symbols to collapse them. 

When you click a node in the tree, any links for that node will be displayed in the 

list on the right.  

Creating a Link 
To create a link: 

1. In the left pane of the Link Manager window, drag a node and drop it 

onto another node. 
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For example, we dragged the first annotation on the Dr. Bradley layer onto the 

second annotation to create a link: 

 

The   symbol indicates that the link is a forward link. The   symbol indicates 

the link is a backward link. 

Viewing Links 
The link navigation 
icons and 
commands are only 
enabled if a link 
exists. For example, 
if no previous link 
exists, you will not 
be able to use the 
Previous Annotation 
Link command. 

You can follow links either on the main ImageScope window or from within the 

Link Manager window. (You do not need to have the Link Manager window 

open to follow links.) 

If no annotation is currently selected, the viewing tools will follow slide‐level 

links; if there is more than one link to or from the currently selected annotation 

or slide, then the Link Manager window will open so that you can select a link. 

ImageScope displays the target of the link in its main window. If the target is a 

digital slide, then it will be fitted into the main window; if it is an annotation, 

then the annotation will be centered and zoomed. 

To follow links in the main ImageScope window: 

1. Open a digital slide that contains links. 

2. To go to the next link, go to the View menu and select Next Annotation 

Link, or press Shift+F8, or click the   icon on the ImageScope toolbar. 

3. To go to a previous link, go to the View menu and select Previous 

Annotation Link, or press Shift+F7, or click the   icon on the 

ImageScope toolbar. 

To follow links in the Link Manager window: 

1. Open a digital slide that contains links. 

2. Go to the View menu and select Annotation Link Manager to open the 

Link Manager. 
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3. Click on the node for which links have been created and click   in the 

right pane of the Link Manager window to follow the link. 

Deleting Links 
To delete a single link: 

1. In the Link Manager window, select a link in the right pane of the 

window and click  . 

To delete all links: 

1. In the Link Manager window, click  . 
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12 
Tracking 

A tracker tool provides a way to record your movements 
through a digital slide and to save that record (known as a 
track) with the image as an annotation layer. 

Typical uses for the tracker tool are: 

 Histologists and pathologists might want to use this tool to remind them 

what sections of the digital slide have been visited.  

 The saved track might be useful for quality assurances purposes by 

providing permanent evidence of what sections of the digital slide were 

viewed. 

 The saved track could be used for educational purposes to give students 

a tour of the digital slide. 

To turn on the tracker: 

1. Go to the View menu and select Tracker. The tracker tool appears: 

 

You can move this tool anywhere on your monitor display, even off the 

ImageScope window, so it is out of the way. 

2. To start recording your movements, click the red record button  : 
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When the recording begins, the thumbnail image turns gray. As you 

move, each section of the image you move to is highlighted in the 

thumbnail. The intensity of the highlight shows the resolution at which 

that part of the image was viewed. 

 

For example, after moving through several portions of the digital slide 

shown above, the thumbnail looks like this: 

 

If you want to change the size of the thumbnail to make viewing easier, 

hold and drag the lower left corner of the thumbnail. 
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Tips: 

 If you do not want to see your progress mapped on the thumbnail, clear 

the Map check box on the tracker tool. To show/hide mapping, type 

Control‐M. (You can also set the default value of this check box. See 

“Tracking Options” on page 181.) 

 To automatically move to the next unviewed section, click   on the 

tracker tool. This button moves through the image more or less in the 

way a person would, working left to right, top to bottom. Using this 

button, you can systematically view the entire slide. 

 To stop recording, click   on the tracker tool. 

Viewing a Track 
To view a track: 

1. Go to the View menu and select Annotations. The Annotations window 

appears: 

 

Each track associated with this digital slide is listed in the Layers pane of the 

Annotations window. To see information on each track, click a Track in the 

Layers pane. 

Tips: 

 A + symbol after the Track name indicates the track recording is 

complete. 

 An * after the Track name indicates the track recording is still in 

progress. 

 An indented track (for example, Track 3 in the example above) indicates 

that the track has been appended to the track above it. (See “Appending 

to a Track” on page 107 for information on appending.)  
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 The information in the Layer Attributes pane tells when the selected 

track was recorded.  

 The information in the Layer Regions pane gives information on each 

stage of the recording. The first region of the track is the path that 

connects the center of all the views in the session. The other regions in 

the track are rectangles corresponding to each view in the session. 

 To see a track in the main ImageScope window, select the track in the 

Annotations window and click the eye icon at the top of the Layers pane. 

 As with any annotation layer, you can change the name of the track (for 

example instead of “Track 1+” you can name the track “Dr. David”) by 

clicking on it and typing in a new name. 

Playing a Track 
To play the current track: 

1. Click   on the tracker tool. 

To select a track made in the past: 

1. Open a digital slide.  

2. Go to the View menu and select Annotations. The annotations window 

appears: 

 

3. Select the track you want to play by clicking it in the Layers pane of the 

Annotations window. 

4. Click   on the tracker tool. 

Tips: 

While playing a track, use the tracker tool buttons to affect the playback: 

  – Stop playing or recording the track. 
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  – Go to first view in the track. 

  – Go to the last view in the track. 

  – Go to the next view in the track. 

  – Go to the previous view in the track. 

As you play the track, the Annotations window updates to show your location in 

the Layer Regions pane. 

Appending to a Track 
You can either start a new recording or append to a previous one. If a track 

already exists for this digital slide, when you click the record button, the 

following message appears: 

 

To start a new recording, click No; to append to the previous track, click Yes. 

If more than one track has been created for the digital slide, to append to a 

specific track, open the Annotations window (as discussed above) and select that 

track by clicking on it in the Layers pane before clicking the record button. 

When a track is appended, the recording starts off as if all the views in the parent 

track have already been viewed. 

See “Viewing a Track,” on page 105 for an example of an appended track. 
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13 
Saving Digital Slides and 

Regions 

This chapter discusses several different ways to save images 
of digital slides. 

Taking a Snapshot 
You can capture a picture of the digital slide you are viewing by using the Save 

Snapshot command. The image is saved in JPEG or TIFF format. 

1. Navigate to the area of the digital slide you want to capture so that it is 

displayed in the main ImageScope window. 

2. Go to the File menu and select Save Snapshot or click   on the toolbar. 

3. In the Save Snapshot window, browse to the location where you want to 

save the file. 

 

4. Type a name for the file in the File name box. 

5. In the Save as Type drop‐down list, select TIFF Files or JPEG Files. 

6. Click Save. 

To view the file you saved, use Windows Explorer to browse to the folder 

location where you saved the file and double‐click the file name. Or, you can 
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navigate to that location from within ImageScope and open the file with the 

ImageScope Open command. 

Color Management 
When you make a snapshot, and if the original image has an ICC profile 

embedded in it, ImageScope transforms the image using the monitor ICC profile 

if Integrated Color Management is turned on in ImageScope or embeds the 

ScanScope ICC profile if Integrated Color Management is turned off. 

Saving an Image to the System Clipboard 
You can save the image currently being displayed to the system clipboard by 

going to the Edit menu and selecting Copy (or type Control C). You can then 

paste the image from the clipboard into an image processing application like 

Microsoft Paint or Adobe Photoshop. 

Extracting a Region 
You can extract selected regions of a digital slide in different formats and open 

the extracted region in another application if required. When you extract a 

region, you can define the exact size of the new image or use a predefined fixed 

size, which can be very useful when preparing images for presentations or 

publication (see “Saving an Image of a Specific Size” on page 114). 

Using the Extraction Tool 
To extract a region: 

1. Click   on the toolbar. 

2. Place your cursor on the digital slide. 
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3. Click and drag a rectangle on the screen to capture the area: 

 

When you release the mouse button, the following appears: 

 

4. Select among the following options: 

Option Description 
Output File Location where you want the extracted region file to be saved 

and name to be used. If you do not use the Output File button, 
the new file will be created in the same location as the original 
digital slide and with the same name but with a number 
appended to it. For example, if the original digital slide file name 
is vs025_40Xn.svs, the extracted region is named 
vs025_40Xn_001.svs. (If a _001 file already exists, the extracted 
region file name ends in _002. If a _002 file already exists, the 
new file name ends in _003, and so on.) 

Description Your title for the extracted region. 
Left Left pixel co-ordinate of the original image. 
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Option Description 
Top Top pixel co-ordinate of the original image. 
Width Width of the extracted image in pixels. 

Height Height of the extracted image in pixels. 
Thumbnail Attach the thumbnail of the exported image. 
Label Attach the label image from the original scan if it exists. 
Macro Attach the macro image from the original if it exists. 

Tile Size Determines the organization of the data within the extracted 
image. For large SVS and TIFF files, a tile size of 240 or 256 is 
optimal to enable fast access to the image.  
If you want to extract images for use with a third-party program 
which doesn’t support blocked TIFF files, you can set the tile size 
to zero to create a “stripped” image. Stripped TIFF files are 
supported by all software which processes TIFF files, but there is 
a performance penalty for large images (it does not affect small 
images). JPEG files are always stripped (tile size is always zero). 

Output/ 
Compression 

The different file formats you can select for the saved image and 
their compression options: 

 SVS file format using JPEG2000 or JPEG compression 
 JP2 file format using JPEG2000 compression 
 TIF file format using LZW or no compression 
 JPG file format using JPEG compression 
 CWS file format using JPEG compression 

ICC Profile If an ICC profile has been embedded in this image, you can select 
how it will be managed in the extracted image (embedded, 
applied, ignored). For information on Aperio color management, 
see Appendix B, “Aperio Integrated Color Management” on page 
193. 
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5. Choose the options you require and click Extract. You see a progress bar 

showing the status of the extraction.  

When the extraction is complete, you see additional buttons for viewing 

the image: 

 

6. Click View to open the extracted image in ImageScope. (For information 

on the Launch button, see “Managing Viewing Applications” on page 

115.) 

Color Management Options 
When you extract a region from ImageScope, you can specify one of the 

following: 

 Embed – The ScanScope ICC profile will be embedded in the image. 

 Apply – The image will be transformed using the monitor ICC profile. 

 Ignore – No color management will be done. 
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Saving an Image of a Specific Size 
To create an image of a specific size: 

1. Follow the steps above to capture the area you want to extract. 

2. When the Extract Image Region window appears, adjust the size of the 

saved file by changing the settings in the Width and Height boxes. 

 

Tips: 

 The first column of numbers after Width and Height is the number of 

pixels of the original extracted image. The second column is the output 

dimensions, initially set the same as the original values.  

 The percentages show the ratio between the original dimensions and the 

output dimensions. The check mark in the box causes both the width and 

height to be adjusted proportionally (thus preventing the image from 

being distorted). You will usually want to keep the box checked. 

 You can change the percentages to make an image smaller. If you are 

extracting a number of images, using the same percentage for them all 

will ensure they will all have the same resolution. You can also adjust the 

percentage to greater than 100 to make the image larger. 

 Instead of changing the percentages, you can define a specific output 

dimension by typing the exact number of pixels you want for the height 

and width in the second width and height columns. 

Extracting an Image of a Predefined Size or Aspect Ratio 
If you have predefined a fixed size (see “Fixed Size Annotations” on page 180), to 

extract an image in the predefined size, hold down the Control key while you 

click the extract tool   on the toolbar. 

To extract an image using the same aspect ratio of the predefined size (but not 

necessarily the same size), hold down the Shift and Control keys while you use 

the extract tool to draw the region to extract. 
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Managing Viewing Applications 
You can define applications other than ImageScope to be used to view extracted 

regions. Doing so defines what viewing application ImageScope will launch from 

the Extract Image Region window, but of course you can also open the extracted 

file outside of ImageScope using any compatible image viewing software (see the 

next section). 

Compatibility Notes 
Be aware that the viewing application you define may not be able to open an 

image of the type you’ve extracted. For example, Internet Explorer cannot open 

TIFF files, but can open JPEG files. If you click Launch and the application is not 

able to open the extracted file, you will see an error message from the application 

similar to “Cannot open this type of file.” 

Also, the viewing application you define may not be able to handle a file as large 

as your extracted file. Some applications have a limit on the size of file they will 

open and work with. 

Some third‐party programs cannot handle TIFF files which use any form of 

compression. When in doubt, you can always specify None for compression of 

TIFF files. However, if the region is large, using no compression will result in a 

very large file.  

Defining a Viewing Application 
To define a viewing application: 

1. Follow the instructions above to capture and extract a region of a digital 

slide. 
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2. Click the drop‐down box next to the Launch button and select Define 

Application.  

 

If no applications have previously been defined, this list will be empty 

except for this selection. If applications have been defined, they will 

appear in alphabetical order. 

The following window appears: 

 

3. Type a description of the application (for example, Photoshop) in the 

Application Name text box. This can be any text you want to use. 

4. Click Browse to navigate to the location of the application executable file 

and select that file. 

5. Click Add to add this application to the list of ImageScope viewing 

applications. 

6. Click Done.  
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Using the Viewing Application 
To view an extracted region with a viewing application (after one has been 

defined): 

1. Follow the steps above to extract a region. 

2. Click the drop‐down box next to the Launch button and select a viewing 

application. 

3. Click the Launch button. (If no applications have yet been defined, the 

Launch button is disabled.) 

Deleting Viewing Applications 
To delete applications previously defined: 

1. Follow the steps above to extract a region. 

2. Click the drop‐down box next to the Launch button and select Define 

Application.   

The following window appears: 

 

3. Click the Application Name drop‐down box and select the application 

you want to delete from the list of ImageScope viewing applications. The 

Add button now changes to a Delete button. 

 

4. Click Delete to delete the application from the list of ImageScope 

viewing applications. (This does not delete the application from your 

disk, but only from the list of ImageScope viewing applications.) 

5. Click Done. 
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14 
Analyzing Digital Slides 

This chapter discusses how to use algorithms to analyze 
digital slides. We discuss the general-purpose analysis 
procedure that uses the Annotations detail View. For 
information on streamlined digital IHC analysis, see “The 
Annotations Window Summary View Window – Quick IHC 
Analysis” on page 81. 

This chapter 
discusses using 
Aperio image 
analysis algorithms 
to analyze digital 
slides. 
 
Aperio's image 
analysis algorithms 
are FDA cleared for 
specific clinical 
applications, and are 
intended for 
research use for 
other applications. 

Analyzing digital slides helps you to examine the slide staining to find any 

unusual patterns. Using an algorithm to look for these patterns provides precise, 

quantitative data that is accurate and repeatable. 

About Analyzing Digital Slides 
There are three different types of analyses you can perform on digital slides: 

1. You can use ImageScope to analyze a single, remote digital slide that 

resides on Spectrum. In this case, the analysis results are stored remotely 

with the image in the Aperio database. 

2. You can use Spectrum to analyze a single digital slide or a batch of 

digital slides that reside on Spectrum. Results are stored in the Aperio 

database. For information on submitting batch jobs to analyze groups of 

digital slides, see the Spectrum/Spectrum Plus Operator’s Guide. 

3. You can use ImageScope to analyze a single, local digital slide that 

resides on your workstation or network location accessible by Microsoft 

file sharing. In this case, the algorithm analysis results are stored locally 

with the image as annotations. 

Note that the ImageScope user interface is somewhat different depending on 

whether you are analyzing a local or a remote image. Please see the sections that 

follow for details: 

 “Analyzing a Digital Slide in Spectrum” on page 120. 

 “Analyzing a Local Digital Slide” on page 124. 

Also note that before you can analyze a remote digital slide, you must fine‐tune 

the algorithm parameters and save the settings as a macro. See Chapter 

15,“Registering Algorithm Macros on Spectrum” on page 133. 
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Partial or Full Analysis 
You can analyze an entire digital slide image or you can use the annotation tools 

to pick just an area to analyze. You can even draw an annotation that excludes an 

area from analysis. 

Results from the Analysis 
You can save algorithm analysis results as a visual “markup image” and also as 

quantitative data that can be exported to be read by a spreadsheet program. The 

analysis results can also appear in Spectrum if slide‐specific processing is set up.  

In all cases, the original digital slide image is never modified. Rather, a new 

annotation layer with the markup image and quantitative data is created and 

linked to the image. 

Algorithms 
The process of analyzing a digital slide is done by applying algorithms directly 

to the digital slide or selected regions of the digital slide. 

The Positive Pixel Count algorithm and Positive Pixel Count FL (for fluorescence 

images) are provided for free with Aperio software and installed with 

ImageScope. Other algorithms are available from Aperio for a fee. Algorithms 

have also been developed by third parties and tools are available from Aperio for 

creating your own algorithms. Contact Aperio for details. 

Algorithms all have control parameters—for example, intensity and hue 

settings—that allow the algorithm to be tailored to your specific needs. See the 

algorithm documentation for information on specific algorithms. 

Note that Aperioʹs image analysis algorithms are FDA cleared for specific clinical 

applications, and are intended for research use for other applications. See the 

documentation for the specific Aperio clinical application for details on the 

intended use of that application. 

For general information on using Aperio algorithms, see the Aperio Image 

Analysis User’s Guide. 

Analyzing a Digital Slide in Spectrum  
When you open a digital slide in Spectrum, the analysis runs on Spectrum, 

freeing your workstation to do other things. The results of the analysis are stored 

in Spectrum as an annotation layer of the digital slide. 

Incremental Analysis 
Some Aperio algorithms support incremental processing. Incremental processing 

allows the algorithm to analyze only regions added after the initial analysis 

without re‐analyzing the previously analyzed regions. This can save a great deal 

of time and is useful when a pathologist draws a single region and analyzes it, 
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and after reviewing the analysis results wants to select additional regions and 

analyze them as well. The pathologist can add more annotation regions as 

needed or delete annotation regions and the analysis results will be updated 

accordingly. 

If you delete a region, ImageScope will automatically re‐run the analysis to 

update the summary analysis results. However, adding regions may make the 

analysis results incorrect until you re‐run the analysis. 

Opening a Remote Digital Slide 
Log into Spectrum and select and open a digital slide in ImageScope. See 

“Opening a Digital Slide on Spectrum” on page 12 for instructions. 

Selecting an Area of the Digital Slide to Analyze 
Only the rectangle 
and free-form pen 
tools can be used to 
draw annotation 
regions to include in 
analysis. Only the 
free-form negative 
pen tool can be used 
to draw annotation 
regions to exclude 
from analysis. 

If you want to analyze only part of the digital slide, use the pen or rectangle 

drawing tool to select the area to analyze, or use the negative pen to exclude an 

area from analysis. (See Chapter 9, “Annotating Digital Slides” on page 75 for 

details on the drawing tools.) If you do not draw areas to include or exclude from 

analysis, ImageScope will analyze the entire digital slide.  

Here is an example of an area of analysis drawn by using the free‐form pen tool: 
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Performing the Analysis 
To analyze the digital slide: 

1. Go to the View menu and select Analysis. You are asked to specify 

which algorithm you want to run.  

 

The list you see depends on which algorithm macros are installed on 

Spectrum. If you do not see any algorithms listed or do not see the one 

you want to use, see Chapter 15, “Registering Algorithm Macros on 

Spectrum” on page 133 for information on creating macros.  

To create a macro on Spectrum, you must be logged in as a Spectrum 

administrator—if you are, the Test and Create buttons on this window 

are enabled. 

2. Select the algorithm you want to use. If you want to create a visual 

representation of the analysis as well as a quantitative one, select the 

Generate Markup Image check box. 

3. If this algorithm supports incremental processing, you can select the 

Incremental Processing check box to use that feature (see “Incremental 

Analysis” on page 120). (If the check box is not enabled, this feature is 

not available with this algorithm.) 
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4. Click Analyze to start the analysis. A progress bar in the filmstrip shows 

the status of the analysis.  

 

You can also check the status of the analysis by going to Spectrum and 

using the Analysis > Jobs command. 

5. Open the Annotations window to see the quantitative results of the 

analysis, which are listed under the layer containing the annotations that 

define the area of analysis. Note that the quantitative results are color 

coded to match the mark‐up image. (See “Algorithm Analysis Results” 

on page 130 for more information.) 

 

If you selected the Generate Markup Image check box on the Algorithm Server 

Job window, the ImageScope main window also shows a visual representation of 

the analysis: 

 

Saving Analysis Results 
Both visual and quantitative results from a remote analysis are stored in the 

Spectrum database linked to the digital slide. 

To save the quantitative results in a plain text form that can be imported into a 

spreadsheet program, click   on either the Layer Attributes pane to export the 
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combined results for all annotation regions on the selected layer or the Layer 

Regions pane to export the results in text format for each annotation region. 

Or, click the   icon on the Layer Attributes or Layer Regions pane to save the 

data as an Excel spreadsheet. Numeric data exported to a spreadsheet is exported 

as text. Excel shows a warning note for each of these cells that the numbers are in 

text format—when you click on the note you can select an option to transform 

the text to numeric format. 

See “Algorithm Analysis Results” on page 130 for more information.  

Analyzing a Local Digital Slide  
1. Open a digital slide you want to analyze on your workstation or local 

network. (See Chapter 3, “Opening a Digital Slide” on page 11.)  Only the rectangle 
and free-form pen 
tools can be used to 
draw annotation 
regions to include in 
analysis. Only the 
free-form negative 
pen tool can be used 
to draw annotation 
regions to exclude 
from analysis. 

2. If you are going to analyze only a portion of the digital slide, use the 

rectangle or free‐form pen annotation drawing tools to: 

 Select one or more areas to analyze; or 

 Select one or more areas to exclude from the analysis. 

(See Chapter 9, “Annotating Digital Slides,” on page 75 for information 

on using the annotation tools.) 
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3. Go to the View menu and select Analysis. The following window 

appears: 

 

The last algorithm that was used is displayed in the Algorithms window. (Or if 

none has yet been used locally, this window is blank.)  

Note that this window differs from the algorithm parameter window shown 

when you create an algorithm macro for a digital slide opened from Spectrum—

there are no input/output buttons as you are not saving data on Spectrum and so 

do not need to specify which outputs to export to Spectrum. 

On this window you can: 

 Select another algorithm to use 

 Select whether to analyze the entire digital slide, just the portion of the 

digital slide on the ImageScope main window, or just a selected 

annotation. 

 Import or export algorithm settings from or to your workstation. 

 Modify algorithm settings 
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 Select whether to show the analysis results visually (markup image) as 

well as quantitatively. 

 Click Run to run the analysis using the current parameter settings. 

 Click Tune to open a tuning window to see instant feedback on 

parameter changes. See “Using the Tuning Window to Test Algorithm 

Parameters” on page 141 for details. 

Selecting an Algorithm 
If you want to use an algorithm other than the one displayed in the Algorithms 

window, click Select Algorithm. The following window appears: 

 

The Positive Pixel Count algorithm is installed with ImageScope. If you have 

purchased and installed other algorithms, you will see them listed in this 

window also. Select the algorithm you want to use and click Select. 

Note that the macros you create will work only with the version of the algorithm 

with which you created it. For example, if you previously created a macro to 

work with version 8.1 of the Positive Pixel Count Algorithm, you will see an 

error message if you try to use it with version 9 of the Positive Pixel Count 

Algorithm.  

Selecting the Region of Analysis 
You can choose to analyze: 

 Current Screen – Analyzes just the portion of the digital slide on the 

ImageScope main window at the current zoom level. This is useful for 

testing the behavior of an algorithm and fine‐tuning the algorithm 

parameters. 

 Entire Image –  Analyzes the entire digital slide. This can take a long 

time to complete depending on the size and complexity of the image. 

 Selected Annotation Layer – Analyzes one or more annotations on the 

selected annotation layer or excludes from analysis one or more 

annotations (if they were drawn using the negative pen tool). Open the 

Annotations window and make sure the annotation layer containing the 
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areas you have drawn is selected. (See Chapter 10, “Using the 

Annotations Window,” on page 81 for information on annotation layers 

and the Annotations window.) 

Modifying Algorithm Parameters 
You can modify algorithm parameters to fine‐tune the algorithm for your needs. 

1. Click a parameter listed on the Algorithms window. If you can modify it, 

you either see: 

 The edit icon  . Type a new value into the field or click the edit 

icon to select a new value using a slider control: 

 

 A down arrow, which means you can select from the drop‐down list: 

 

For information on the parameters for a particular algorithm, refer to the 

documentation that accompanies that algorithm. 
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Enabling Data Plots 
When you are creating a macro for an algorithm that supports data plots, unless 

that algorithm enables plots by default, you will need to select plots in the 

algorithm input parameters. For example: 

 

Depending on the algorithm, once plots are enabled, you may also be able to 

select details about the plots. For example, in this algorithm parameters list you 

can specify the beginning and end values of the different plots: 

 

Importing/Exporting Macros 
Once you have fine‐tuned the algorithm parameters, you can save the algorithm 

and its changed parameters so you can use the modified algorithm again in the 

future. (The algorithm + modified parameters is known as a macro.) 

1. Click Export Macro.  

2. On the File Save window, type a descriptive file name in File name and 

click Save. 

To import a previously saved macro, click Import Macro and select the macro 

file from the file selection window. 

(To register the saved macro on Spectrum, log into Spectrum as an administrator 

and use the Analysis > Macros > Add command. See the Spectrum/Spectrum Plus 

Administrator’s Guide for details.) 
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Running the Analysis 
Instead of clicking 
Run, you can click 
the Tune button to 
open a tuning 
window in which you 
can see instant 
feedback on 
parameter changes. 
See “Using the 
Tuning Window to 
Test Algorithm 
Parameters” at the 
end of the next 
chapter for details. 

1. Go to the View menu and select Annotations. This opens the 

Annotations window where the quantitative portion of the analysis 

results will be displayed.  

If you drew annotations to include or exclude regions from the analysis, 

click on the annotation layer containing the annotations in the 

Annotations window to make sure the correct annotation layer is 

selected. 

2. If you also want a visual representation of the analysis results, select the 

Generate Markup Image check box and you will see the results on the 

image in the ImageScope main window. 
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3. Click Run. As the analysis proceeds, you see status information 

displayed on the Algorithms window: 

   

Algorithm Analysis Results 
When the analysis is done, the Algorithms window displays “Analysis 

complete.” If you analyzed this slide locally, the results are not saved in 

Spectrum, but are saved in an annotations file where the local file resides. 

A new annotation layer appears in the Annotations window which contains the 

quantitative results of the analysis. For example: 
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The results for each annotation region are listed in the Layer Regions pane. The 

combined results for all annotation regions are listed in the Layer Attributes 

pane. 

To save these results in a plain text form: 

1. Click   on either the Layer Attributes pane (to export the combined 

results) or the Layer Regions pane (to export the results for each 

annotation region). 

2. On the file save window, type a descriptive name in the File name text 

box and click Save. 

Or, click the   icon on the Layer Attributes or Layer Regions pane to save the 

data as an Excel spreadsheet. Numeric data exported to a spreadsheet is exported 

as text. Excel shows a warning note for each of these cells that the numbers are in 

text format—when you click on the note you can select an option to transform 

the text to numeric format. 

Viewing Result Plots in ImageScope 
If the Annotations 
window is in 
summary view, and 
you run an analysis 
using an algorithm 
macro in which data 
plots are enabled, all 
data plots will 
automatically open 
in individual 
windows when the 
analysis is complete. 

After you run an algorithm for which plots are enabled, to see the resulting plots, 

go to the View menu in ImageScope and select Annotations. 

On the Annotations window in detailed view, click the Plots icon,  . 

 
Location of Plots Icon on ImageScope Annotations Window 

If you do not see the Plots icon, make sure the Annotations window is in detailed 

view, and not summary view. (If you only see summary view and there is no 

Details button to return to detailed view, you are in clinical viewing mode—go 

to the View menu and select View Standard Toolbar.) 
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After clicking the Plots icon, a plot window opens containing links to the various 

plots available for viewing.  

 

Click a link to see that histogram. The window appears for that plot. You can re‐

size this window by grabbing a corner of it and dragging. 

 

Note the icons on this window: 

Legend Click to see the definition of each colored curve. For example: 

 

 Set up printer so that you can print the plot. This opens the standard dialog window for 
your printer so you can choose paper size and other printer options. 

 Print the plot. 

 Make the plot window transparent so you can see the digital slide image through it. 

 Restore window to original size. 

Purdue University is an equal access/equal opportunity/affirmative action university. 
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15 
Registering Algorithm Macros 

on Spectrum 

This chapter discusses how to create and save an algorithm 
macro so it can be used on Spectrum. You must be logged 
into Spectrum as an administrator to perform this 
procedure. 

Before you can use an algorithm to analyze a digital slide in Spectrum, a macro 

(an algorithm’s settings) must first be registered on Spectrum.  

To create an algorithm macro, you need to install the algorithm on both your 

local workstation and on Spectrum. (This consists of simply running the 

algorithm installer on both computers.) 

Creating and Saving a Macro 
To create a macro, you will: 

1. Open a digital slide in ImageScope from Spectrum. 

2. Select an Algorithm from which to make a macro. 

3. Create the macro. 

4. Save the macro on Spectrum 

Open a Digital Slide 
To open a digital slide from within Spectrum: 

1. Log into Spectrum as an administrator. 

2. Use the Spectrum List commands to see the digital slides on your site or 

use the search feature to find the one you want. 
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3. Select the digital slide you want to use and click View Images: 

 

The digital slide opens in ImageScope. 
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Create a Macro 
1. Go to the ImageScope View menu and select Analysis or type Control G. 

You see the Algorithm Server Job window: 

 

The Test and Create 
buttons are disabled 
if you are not logged 
in as a Spectrum 
administrator as 
only administrators 
can create and 
modify algorithm 
macros. 
 
The Analyze button 
is disabled if your 
user permissions are 
not set to Full 
Control for the data 
group containing the 
digital slide image. 

2. Now click Create. The Select an Algorithm window appears: 

 

3. Select the algorithm you want to create a macro for and click Select.  
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This loads the algorithm macro with its default parameters so you can 

see its unmodified parameters.  

 

4. Modify the Input parameters to suit your application. 

Click a parameter listed on the Algorithms window. If you can modify it, 

you either see: 

 The edit icon  . Type a new value into the field or click the edit 

icon to select a new value using a slider control: 
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 A down arrow, which means you can select from the drop‐down list: 

 

For information on the parameters for a particular algorithm, refer to the 

documentation that accompanies that algorithm. 

When you are creating a macro for an algorithm that supports data plots, 

unless that algorithm enables plots by default, you will need to select 

plots in the algorithm input parameters. For example: 

 

For information on viewing result plots, see the previous chapter. 

The Classifier Neighborhood, Classifier, and Class List parameters are only 

used if you are using Genie classifiers with this algorithm. Your 

Spectrum administrator can tell you if Genie classifiers are available on 

your Spectrum site. (Genie is a histology pattern recognition tool that 

works with Aperio algorithms to automatically identify tissue types for 

analysis. For more information, see the Genie User’s Guide.) 
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5. Click Outputs to select what results you want to display in Spectrum. (If 

you are analyzing a local slide, you will not see the Input/Output buttons 

as the results won’t go to Spectrum.) 

 

Clear the check boxes next to the results you don’t want to display in 

Spectrum. 

6. Click Run to test the algorithm on the digital slide. You can see the 

results in the ImageScope Annotations window: 

 

And in the mark‐up images in the ImageScope window. 

Instead of clicking 
Run, you can click 
the Tune button to 
open a tuning 
window in which you 
can see instant 
feedback on 
parameter changes. 
See “Using the 
Tuning Window to 
Test Algorithm 
Parameters” at the 
end of this chapter 
for details. 

7. When you are satisfied with the results, save the macro on Spectrum (see 

the next section). 
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Save the Macro on Spectrum 
After you have created the macro, save it to register it on Spectrum. 

1. On the Analysis window, click Save Macro to save the macro and 

register it on Spectrum: 

 

2. You are asked to enter a name for the macro: 

 

Type a name that will help you identify the macro in the future and click 

OK.  
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You now see a message letting you know that the macro is saved. It is 

now registered on Spectrum. 

 

Testing and Modifying an Existing Macro 
The Test button modifies an existing macro and tests it before saving it to 

Spectrum.  

1. Open a digital slide on Spectrum. 

2. Go to the View menu and select Analysis or type Control G. 

3. Select a macro from the Algorithm Server Job window and click Test. 
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This loads the algorithm macro with its existing parameters.  

 

4. Modify the parameters as discussed in the previous section and click 

Run to test the macro on the digital slide or click Tune to see immediate 

feedback on parameter changes (see the next section for details). 

5. On the Analysis window, click Save Macro to save the macro and 

register it on Spectrum. 

6. You are asked to enter a name for the macro. Type a name that will help 

you identify the macro in the future and click OK.  

Using the Tuning Window to Test Algorithm 
Parameters 
The purpose of the algorithm tuning window is to give you way to quickly see 

the results of analyzing a different area of an image or to test changes you make 

to the algorithm parameters. 

To use the algorithm tuning window: 

1. In Spectrum, open a digital slide in ImageScope. 

2. In ImageScope, go to the View menu and select Annotations to open the 

Annotations window. This window is where your numeric algorithm 

analysis results appear. 
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3. Go to the View menu and select Analysis.  

You see the Algorithm Server Job where you can select the algorithm 

macro you want to use. 

 

These instructions 
discuss using the 
tuning window when 
opening an image 
from Spectrum. 
 
You can also use the 
algorithm tuning 
window when you 
open a local image—
just remember that 
in this case analysis 
results will be saved 
locally, not in the 
Spectrum database. 
For details on 
analyzing local 
images, see the 
previous chapter. 

4. Select the macro you want to use and click Test. You see the algorithm 

parameter window. 
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5. On the algorithm parameter window, click Tune. On the ImageScope 

main window, you see a new Algorithm Tuning window with the mark‐

up image from the analysis using the current parameters. 

 

Click the eye icon to turn the mark‐up display on or off. 

 
You see the numeric results of the analysis in the Annotations window 

Tuning Layer: 
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6. To adjust the size of the Algorithm Tuning window, grab a corner until 

you see the double‐headed arrow and pull the window to change the 

size. 

 

Every time the 
Algorithm Tuning 
window updates the 
analysis, a new 
mark-up image 
appears in the 
window and the 
numeric data in the 
Annotations window 
changes to reflect 
the new analysis. 

7. To see the analysis of another area of the digital slide, drag the 

Algorithm Tuning window to another area or move the digital slide 

under the window. 

8. To see the results of the analysis when you change the parameters, 

simply change the parameters in the algorithm parameters window and 

the tuning window will update. 

Note on the Algorithm Tuning Window 
The purpose of the algorithm tuning window is to give you way to quickly see 

the results of analyzing a different area of an image or to test changes you make 

to the algorithm parameters. If you are viewing the digital slide in ImageScope at 

the same magnification as the one used to create the digital slide (for example, 

you scanned the glass slide at 20x and you are viewing the resulting digital slide 

at 20x), then the tuning window will give the same results as running the 

algorithm on the selected area. If you are viewing the digital slide at a different 

magnification than its original scan magnification, the tuning window results 

may differ slightly from those obtained by running the algorithm on the same 

area. 
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16 
Digital Slide Conferencing 

Digital slide conferencing makes it possible for several 
participants to view the same digital slide from multiple, 
remote locations. This section discusses how to use the 
Digital Slide Conferencing feature of ImageScope.  

About Digital Slide Conferencing 
ImageScope Digital Slide Conferencing (DSC) not only allows multiple people to 

see the same digital slide at the same time, but also provides the following 

features: 

 Synchronized viewing so all participants see the same region of the 

digital slide at the same time 

 Real‐time annotation sharing 

 Leader/follower roles and the ability to change those roles 

All conference participants must have ImageScope installed on their 

workstations. (Download the latest free ImageScope software from 

www.aperio.com.) 

Concepts 
 The person hosting the conference is called the leader. This is usually the 

person who created the conference.  

 Participants who join the conference are called followers. Followers can 

see the digital slide the leader opens on the ImageScope viewer along 

with any annotations the leader makes. 

 Conferencing requires that all parties have access to a common DSC 

server and a common ImageServer or network share where images are 

stored. 

Starting a Digital Slide Conference 
1. Log into Spectrum and open a digital slide by clicking a digital slide 

thumbnail on a Spectrum page. 
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2. Go to the View menu and click Digital Slide Conferencing. The 

following window appears:  

 

Connecting to a Digital Slide Conferencing Server 
1. On the Digital Slide Conferencing window, click DSC Server. The 

following window appears: 
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2. Type the following information: 
If you set up the DSC 
server on your 
workstation, make 
sure your 
workstation is 
accessible to others. 
See your network 
administrator if 
necessary to make 
sure the correct 
ports are open, 
firewall permissions 
are set 
appropriately, and 
so on. 

 Server Name – The example shows a DSC server running at 

dsc.scanscope.com. Type in the name of the server on your network 

that is running the DSC service. Usually this is on your DSR, a 

dedicated server, or it may be on your workstation. 

 Port – Type the number of the port that has been configured for 

DSC. This is usually 80, but can be set to another port. 

 Email Address – This is not required.  

 Password – This is not required. 

 Screen Name – Type the name you want to use as the leader of the 

conference; the conference participants will see you identified by this 

name in the conference participant list. 

3. Click Login. The status changes to Connected and the Create 

Conference button is enabled.  

Creating a Conference 
1. Click the Create Conference button and you are asked to enter the name 

of your conference: 

 

2. Enter any name you wish and click OK. You are notified that you are the 

conference leader: 
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The baton next to your name   indicates that you are the conference 

leader. 

   

3. If you want your mouse cursor to appear on the participants’ view, select 

the Show Mouse check box. 

The conference has now been created. 

Opening an Image to Share 
The conference leader may open one or more digital slides to share in the 

conference. Because all participants must have access to the images too, the 

leader must open images on an ImageServer using the Access Remote Server 

command or directly from Spectrum. (You cannot share images in a digital slide 

conference if they are only on your workstation.) 

Joining a Conference 

The leader can open 
multiple images and 
then move between 
them during the 
conference using the 
ImageScope 
filmstrip. 

Once a conference has been created, participants may join. 

1. Log into Spectrum and open any digital slide by clicking on a digital 

slide thumbnail on a Spectrum page.  
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2. Follow the instructions in “Connecting to a Digital Slide Conference 

Server” on page 146 to connect to the DSC server. The following window 

appears listing any conferences running on that server: 

 

Type the screen name you want to display to the other conference 

participants. 
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3. In the Conferences section select the conference you want to join and 

click Join Conference. The Digital Slide Conferencing window appears, 

listing you as a participant: 

 

In the ImageScope window you now see the digital slide the conference 

leader has opened to share. 

Viewing Slides in Conference 
The conference leader is in charge of the conference: 

 As the leader zooms and pans the digital slide, the view of the other 

participants changes to reflect what the leader is doing. The leader’s 

mouse position is visible as a pointer on each participant’s monitor if the 

leader selected the Show Mouse check box. 

 Each participant may have a different screen size or window layout; each 

window is kept centered following the leader’s actions, but the image is 

adapted to the participant’s window configuration and monitor 

resolution. 

 Only the leader can add annotations; these are seen by all participants. 

Changing the Conference Leader 
There may be times when either the leader or one of the followers wishes to 

change the conference leader. For example, one of the followers may wish to 

point to something on the digital slide for the other participants or the leader 

may leave the conference before it is finished. 

If the leader of the 
conference exits the 
conference before it is 
finished, the next 
person who joined 
automatically becomes 
the leader. 
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When conference leadership changes, ImageScope lets you know: 

 

Leader Initiates Change in Leadership 
If the leader wishes to assign leadership to another participant: 

1. Select a follower in the list of participants and click Assign. The new 

leader receives the message: 
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Follower Initiates Change in Leadership 
If a follower wishes to become the conference leader: 

1. On the Digital Slide Conferencing window, select the Request check box.  

   

The DSC server maintains a list of all participants who want to become 

the leader. An hourglass appears next to the names of followers waiting 

to become the leader. 

2. The current leader passes leadership to the next waiting participant by 

clicking Relinquish. 
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The requester is notified that she has leadership: 

 

Conference Creator Re-asserts Leadership  
If the person who created the conference wants to become leader again: 

1. On the Digital Slide Conference window, click Grab.   
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17 
TelePath Live 

TelePath Live, also known as Remote Revisit, provides a way 
to connect to your ScanScope remotely.  TelePath Live 

(Remote Revisit) is 
not approved by the 
FDA for clinical use. 

By using TelePath Live to directly connect to your ScanScope, you can: 

 See a live video feed from the ScanScope from a remote location. 

 Capture Z‐stacks so you can view specimens in multiple focal planes. 

 Perform a scan directly from ImageScope. 

ScanScope Compatibility Notes 
 For ScanScopes that contain an AutoLoader—to use the Z‐stack feature a 

slide must be on the slide tray; you cannot capture Z‐stacks from slides 

in an AutoLoader. 

 Some older ScanScope models cannot use the TelePath Live feature; 

contact Aperio Technical Support if you have questions about whether 

your ScanScope can use TelePath Live. 

 ScanScope CS scanners support TelePath Live from all five slide 

positions in the slide tray. 

Before You Use TelePath Live 
There are some things you should do and know before you use TelePath Live. 

Calibration 
Your ScanScope has been calibrated at the factory. However, if while using 

TelePath Live you find that the Live window does not line up with your cursor 

position in the ImageScope main window, you will want to calibrate it again. 

For information on calibrating the ScanScope in preparation for using TelePath 

Live, please see the TelePath Live (Remote Revisit) Setup Application Note. 

Setting up the ImageServerURL 
In order for the Console program View Slide button to bring up images in 

ImageScope that can be used for TelePath Live, the ImageServerURL parameter 

needs to be set up with your ImageServer name.  
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Here is how to set up ImageServerURL: 

1. Start the ScanScope Console program by clicking Start > All Programs > 

ScanScope > Console. 

2. Open the Configure window. (See your Console User’s Guide for specific 

instructions.) 

3. Click the ScanScope Properties tab. 

 

4. In the Name field, type: ImageServerURL and click Get. 

5. The name of your ImageServer appears in the Value field. 

a) If the ImageServer name is correct, you are done.  

b) If the ImageServer name is not correct or is blank, type the correct 

name of the ImageServer into the Value box and click Update.  

6. Click Close to exit the Configure window. After you exit the Console, 

your change to ImageServerURL will take effect the next time you start 

the Console again. 

Here is a little more information about why you need to set this parameter: 

When ImageServerURL is set to a valid ImageServer machine name, 

ImageScope will open the digital slide by passing the imageID directly to 

ImageServer. ImageServer will then use the database to figure out where the 

digital slide is located. You can tell that you are in the database mode if you see 

a number beginning with the @ symbol in the title bar of ImageScope.  

You must use ImageServer in this database mode in order to save any 

captured Z‐stacks into the database. If ImageServerURL is not set, Z‐stacks 

you capture in ImageScope will not be saved in the database when you open 

the digital slide using the View Slide button in the Console. 

156 ImageScope User’s Guide 
Purdue University is an equal access/equal opportunity/affirmative action university. 

If you have trouble accessing this document because of a disability, please contact PVM Web Communications at vetwebteam@purdue.edu. 



Chapter 17 – TelePath Live (Remove Revisit)  

 

What Is a Z-Stack? 
A Z‐stack is a three‐dimensional image that allows you to view a specimen by 

moving up and down in the focal planes. This is especially useful for viewing 

“thick” specimens. 

Z‐stack images are cataloged in the ImageServer database, and linked to the 

original image as an annotation. One of the reasons for using the TelePath Live 

feature is to capture and view Z‐stack images. See “Capturing Z‐stacks” on page 

163 for more information. 

Connecting to a ScanScope 
Troubleshooting 
Tips 
If you are unable to 
connect to the 
ScanScope, contact 
your network 
administrator to 
verify the following 
conditions are true 
for your network: 
 
 Port 3333 is 

open and 
directed to the 
ScanScope 
controller. 

 Port 82 is open 
and directed to 
the 
ImageServer. 

1. Go to the ImageScope View menu and select TelePath Live. The 

following window appears: 
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2. Click Configure to define which ScanScope to connect to. The following 

window appears: 

 

3. Type the name of the ScanScope and its port (usually 3333).  

4. Define the ImageServer by typing the host name and port number. If you 

are using a ScanScope CS or T3, this will be the same name and port 

number as your ScanScope. 

Note that the name of your ImageServer host will normally be the same 

as the ImageServerURL setting (see “Setting up the ImageServerURL” on 

page 155) unless you access the ImageServer from outside a firewall, in 

which case it may be different—contact your network administrator for 

assistance if you think this may be the case. 

5. Click OK. 

6. On the TelePath Live window, click Connect.  
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7. You will be asked to log in. Enter your Spectrum user name and 

password. 

 

After a few seconds, you see a window that looks something like this, 

showing slides that are loaded in the tray. You are now connected to a 

ScanScope. 

 

The blue dot indicates the slide you are working on. You can click on any 

slide displayed to work with that slide. 
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If instead the window has no slides displayed: 

 

Click the Refresh Snapshots button to tell the ScanScope to load macro 

slide images.  

Preparing a Slide for TelePath Live 
There are two ways to prepare a slide to be used with the TelePath Live window: 

1. Scan a slide on the ScanScope and click the View Slide button in the 

Console. When ImageScope opens, it knows about the slide and you can 

begin placing Z‐stack images on the digital slide from the ImageScope 

TelePath Live window. 

2. Use the Revisit Quick Scan or Revisit Hi‐Res Scan buttons on the 

ImageScope TelePath Live window. (See “Capturing Z‐Stacks” on page 

163.) 
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Viewing Live Video from the ScanScope 
Connect to a ScanScope and open the ImageScope TelePath Live window as 

discussed in “Connecting to a ScanScope” on page 157. 

After a scan is performed (see the previous section), click around on a digital 

slide in the TelePath Live window and see a live video feed from the ScanScope 

showing the tissue in the Live window.  

When using TelePath Live, coarse and fine focus sliders provide fine‐resolution 

focusing, allowing you to fine‐tune the focus: 

 

The right slider’s range is 10% of the entire focus range provided by the left 

slider, centered on the value of the left slider. For example, if the left slider is set 

at 50, the right slider’s range is 50 – 5% of the focus range to 50 + 5% of the focus 

range.  

Use the slider on the left to get the image roughly into focus. Then use the slider 

on the right to fine‐tune the focus.  
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 Adjust the size of the Live window by using the Camera Mode drop‐down 

list to select a window size: 

 

 If you find an area of interest, click the Capture Z‐Stack button on the 

TelePath Live window to capture a Z‐stack (3‐dimensional) image of that 

area. (See the next section.) 
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Capturing Z-stacks 
1. Open the TelePath Live window and connect to a ScanScope as 

discussed in “Connecting to a ScanScope” on page 157. 

 

The blue dot indicates the currently selected slide. Click on any other 

slide if you want to use it instead. 

2. Choose your Z‐stack options: 

 Depth – The total number of microns in the Z‐stack. 

 Frame Count – The number of individual snapshots taken. The limit 

is 50. 

 Camera Mode – The width and height of the Z‐stack snapshots. 

These are limited by the available modes of the area camera. 

3. If you did not open ImageScope by clicking the View Slide button in the 

Console program, you may need to scan the slide: 

 Clicking the Revisit Quick Scan button on the TelePath Live 

window performs a high‐resolution macro scan of the slide, 

generally used when time is short. The slide will be scanned at 5x. 

 Clicking the Revisit Hi‐Res Scan button on the TelePath Live 

window is the same as pressing the green button on the ScanScope. 

Only the currently selected slide will be scanned, and it will be 

scanned at the currently selected magnification. 

Whether the slide was scanned from the Console or from the TelePath 

Live window, when the slide is scanned its image opens in the 
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ImageScope main window along with a Live window that shows the 

video feed from the ScanScope. 

4. Click on the image in the ImageScope main window. A yellow rectangle 

appears showing what area of the image is displayed in the Live 

window. This also selects the area to perform a Z‐stack capture. To move 

the selection rectangle, click another location in the main image. 

 

5. To capture a Z‐stack from the selected slide, click the Capture Z‐Stack 

button.  
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When you see the message “Opening Z‐stack” on the TelePath Live 

window, the Z‐stack has been captured and you see a green rectangle 

overlaid on top of the yellow rectangle in the ImageScope main window.  

 

Click elsewhere in the image to move the yellow selection rectangle 

away from the Z‐stack image, and you can see the green rectangle 

showing the location of the Z‐stack. 

 

Viewing Z-stacks 
Once you have captured a Z‐stack image, you will see that the Live window now 

contains a coarse and fine focus tool: 

 

To focus through the stack, simply slide the focus bar up and down. 
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18 
Utilities and Diagnostics 

The utilities discussed in this section are primarily for 
troubleshooting problems, and you may be requested to use 
them by Aperio Technical Support if they are trying to 
pinpoint a problem. 

Logging 
If requested to do so by Aperio Technical Support, enable logging by going to the 

Tools menu and selecting Logging. This creates a file named viewport.log into 

which text messages on ImageScope actions are logged. 

Typically, if you are having a problem Technical Support will ask you to: 

1. Turn logging on. 

2. Run until you encounter the problem again. 

3. Then email Technical Support the viewport.log file.  

You should then turn logging off (by again going to the Tools menu and 

selecting Logging) as logging will affect system performance. 

Cache Display 
Because digital slides are typically much larger than can be loaded into memory 

all at once, ImageScope keeps portions of the digital slide in computer memory 

so it can display them quickly. It prefetches data for the digital slide from disk or 

from a remote server, determining which portions of the image to fetch by 

anticipating where the user is going to go next.  

Enable the cache display by typing Shift Control M. (Type Shift Control M again 

to turn it off.) 

The cache display shows which parts of the digital slide are loaded into 

ImageScope’s cache memory. The darker the area, the higher the resolution of 

the part of the image that is loaded. 
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Below is an image of the ImageScope screen showing the cache display: 

 

Running Multiple ImageScopes 
ImageScope normally allows only one instance of itself to run. (If ImageScope is 

open and you try to start it again, the first copy of ImageScope closes.) There may 

be special occasions when troubleshooting a problem or testing Digital Slide 

Conferencing, for example, when you want to run more than one copy of 

ImageScope at a time. 

To run multiple copies of ImageScope: 

1. Click Start and select Run. 

2. Click Browse on the Browse window and navigate to the 

ImageScope.exe file on your workstation. (The default location is: 

C:\Program Files\ScanScope\ImageScope.) 

3. Click Open. 
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The Run window now contains the path to the ImageScope.exe file. 

 

4. At the end of the path specification, type a space and the characters /M 

(outside of the quotation marks) so it looks like this:  

 

5. Click OK. One copy of ImageScope has now started. Repeat this 

procedure again to bring up a second copy of ImageScope. 
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Tuning Parameters/Statistics 
To see how ImageScope is making use of memory and caching: 

1. Go to the Tools menu and select Advanced. The following window 

appears: 

 

Maximum Cache Size 

 Cache Limit – Limits the amount of memory that will be allocated for 

image caching. If you set this to zero, then ImageScope will use up to 

75% of your system’s memory as needed. You will normally want to 

leave this set to zero.  If you want to set the cache limit to a specific size, 

type the number of megabytes you want to use. For example, 128 sets the 

cache limit to 128 megabytes. This is the only value on this screen that 

you can change (except for resetting the statistics to zero). 

Statistics 

The following fields change as you view and pan images. ImageScope only 

reports these values if a digital slide is open. You can reset them to zero by 

clicking Reset (unless noted otherwise below).  

 Available Mem – Total amount of physical memory not in use on your 

system. The Reset button does not affect this value. 

 Total Mem – Total amount of memory installed on your system. The 

Reset button does not affect this value. 

 Cache Max – Amount of cache memory used in megabytes. 

 Cache Used – Current amount of memory cache used in megabytes. 

 Cache Used HWM – High water mark for memory cache in megabytes. 

 Cache Buffers – Current number of buffers stored in cache. 

 Cache Buffers HWM – High water mark for buffers stored in cache. 

 Cache Searches –  Number of cache searches. 
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 Cache Hits – Ratio of cache hits to cache searches. 

 Cache Hits % – Ratio of cache hits to cache searches. 
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19 
ImageScope Options 

Use the Options command to set and review ImageScope 
settings and preferences. 

To access ImageScope’s settings, go to the Tools menu and select Options. The 

Options window appears: 

 

General Options 
The general options are organized into three areas: 

 Magnification  

 Default Gamma Files 

 Analysis 
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Magnification 

 

The magnification options are: 

 Initial Magnification – Specify the initial magnification for images as 

they are opened. This can be a percentage from 1 to 100 or you can 

specify 0 to fit the entire digital slide in the main window display. 

 Maximum Magnification – Specifies how far you can zoom into the 

image. Note that setting this value to greater than 100% does not increase 

the resolution of the image—you are simply enlarging the pixels of the 

existing image. 

 Magnifier Magnification – Specifies the ratio between the main window 

display and the magnifier window. For instance, if this value is set to 3, 

and you are viewing the main image at 50% zoom, then the magnifier 

window will display 150% zoom. See “Using the Magnifier Window” on 

page 36 for information on the magnifier window. 

 Use “X” magnification rather than “%” – Adjusts the Zoom slider from 

displaying magnification in percentages to displaying them as “2x,” 4x,” 

and so on. See “Using the Zoom Slider” on page 37 for examples of the 

Zoom slider in both modes. 
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Default Gamma Files 
Adjusting the display of a digital slide does not affect the original digital slide, 

but only its appearance during the current ImageScope session. You can save 

these adjustments in a gamma table file to be re‐applied in a later session to one 

or more digital slides. (See “Saving and Loading Color Settings” on page 53 for 

information on creating gamma table files.) 

The Default Gamma File sections on the General tab allow you to load specific 

gamma table files every time you start up ImageScope. This can be useful if you 

know you need to compensate for a particular monitor, for example (although a 

better long‐term solution is to calibrate the monitor so it does not have a color 

bias). 

Loading a Default Gamma Table File for the Main Image 
To load a default gamma table file to be applied to all images opened in the main 

ImageScope window: 

1. Select the Automatically load default gamma file(s) check box. 
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2. Use the browse button in the Default Gamma File Location text box to 

search for the gamma table file you want to use. The Select default 

gamma file window appears. 

 

3. To protect the selected gamma table file from being modified, select the 

Open as read‐only check box. 

4. Select the gamma table file you want to use and click Open. 

Loading a Default Gamma Table File for Z-stack Images 
To load a default gamma table file to be applied only to Z‐stack* images: 

1. Select the Automatically load default gamma file(s) check box. 

2. Use the browse button in the Default Gamma File Location – for Z‐

stack Images text box to search for the gamma table file you want to use. 

3. To protect the selected gamma table file from being modified, select the 

Open as read‐only check box. 

4. Select the gamma table file you want to use and click Open. 
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Analysis 
When you run an algorithm† to analyze a digital slide, you can optionally 

request that the analysis generate a visual representation of the analysis in 

addition to providing quantitative data. (See Chapter 14, “Analyzing Digital 

Slides” on page 119 for more.) This visual representation is called a markup image.  

 

 To instruct ImageScope to always generate a markup image by default 

(this setting can be overridden when you actually perform the analysis), 

select the Generate Markup Images check box. 

 To specify the location of the markup file, click the browse button and 

navigate to the location where you want to store this data. (This location 

is used for analyses performed on local digital slides. Remote analyses 

store the markup image only in the Spectrum database.) 
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Navigation Options 
The ImageScope navigation options affect image panning and multiple image 

synchronization. 

 

Synchronization Option 
When you have multiple digital slides open in ImageScope and they are all 

visible at the same time, you can click   or   (yellow) on the toolbar to 

synchronize navigation among the open images. If the image navigation is 

synchronized and you pan or zoom the first image, the other images will show 

the same behavior. The synchronization option defines the behavior of that 

synchronization: 

 Both Pan & Zoom – Synchronizes both panning and zooming. 

 Pan Only – Synchronizes panning only. 

 Zoom Only – Synchronizes zooming only. 
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Panning Options 
Several panning options are available: 

 Scroll Speed – Specifies how fast the image scrolls when holding down 

the mouse button near the edge of an image. 

 Pan Speed –  Specifies how fast the image pans when clicking and 

dragging the image. 

 Reverse panning direction (“Pathologist” mode) – Selecting this check 

box causes panning to move in reverse. With this option disabled, as you 

click and drag the image to the left, the image moves to the left. With this 

option enabled, as you click and drag to the left, the image moves to the 

right. 

Annotation Options 
The Annotations tab of the Options window allows you to select various 

annotation options. 

 

ImageScope User’s Guide 179 
Purdue University is an equal access/equal opportunity/affirmative action university. 

If you have trouble accessing this document because of a disability, please contact PVM Web Communications at vetwebteam@purdue.edu. 



 Chapter 19 – ImageScope Options 

 

Annotation Color Options 
Each annotation layer shows annotations in a different color. The Default 

Annotation Colors section allow you to select the color to be used for each layer.  

1. Click the colored box above the annotation layer for which you want to 

change the color. You see a standard Windows color selection window: 

 

2. Select a color from the palette shown or click Define Custom Colors to 

define your own color. 

3. Click OK. 

If you use more than five annotation layers, the new layers will re‐use the colors 

defined for the first five layers. For example, layer 6 will use the color defined for 

layer 1, layer 7 will use the color defined for layer 2, and so on. 

Fixed Size Annotations 
The Fixed Size Regions options on the Annotations tab set a fixed size for drawn 

annotations that is used when you hold the Control key down while you draw. 

These settings are also used to extract a region of fixed size and to zoom to a 

region of fixed size. 

 Width and Height – these values are used to define the size of rectangles 

or circles. For example, to always draw a square of 200 pixels by 200 

pixels when you hold down the Control key while using the Rectangle 

tool, type 200 into the Width and Height boxes. 

 Length – This value is used for the ruler and arrow annotations. 

See “Report Image Options” on page 185 for information on setting the fixed size 

of a report image. 
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Automatically Saving Annotations 
The Automatically Save Annotation Changes check box saves annotations and 

changes to annotations when you exit ImageScope without prompting for a 

confirmation.  

If this option is enabled, but you have also selected Don’t Save Recorded Tracks 

on the Tracking options tab, tracks will not be saved when you exit even though 

other annotations are. (See the next section for information on tracking options.) 

Tracking Options 
The Tracking tab contains various options that affect tracking, for example 

enabling tracking every time you open a digital slide in ImageScope. For 

information tracking ,see Chapter 12, “Tracking,” on page 103. 

 

The options on this tab include: 

 Automatically Start Tracking on Open – Select this check box to always 

begin recording when you open a digital slide. If a track already exists 

for the digital slide, opening the slide starts appending a track to the 

original track. 
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 Don’t Save Recorded Tracks – Select this check box to disable saving the 

track with the digital slide. 

 Automatically Display Track Map – Select this check box to enable track 

mapping by default. (This selects the Map check box on the Tracker tool.) 

 Minimum Resolution – This option specifies the minimum resolution of 

a view which is mapped. This defines the lowest resolution at which a 

region of the image may be considered to have been viewed. 

 Minimum Magnification – This option specifies the minimum 

magnification of a view which is mapped. This defines the lowest 

magnification at which a region of the image may be considered to have 

been viewed.. 

 Region Granularity – The tracker divides the image into granules when 

deciding what part of the image is glass and what is tissue. By changing 

the granularity, you affect the glass/tissue distinction. Slide the control to 

the left to decrease the granule size and to the right to increase granule 

size. Smaller granules generally mean that less of the image will be 

classified as glass, while larger granules mean more if it will be classified 

as glass. You can see its effect if a tracking map is shown in the 

thumbnail as you move this slider. 

 White Sensitivity – The tracker shows your progress through tissue, not 

glass. This setting helps define what is tissue and what is glass. This 

slider adjusts the “whiteness” of detected glass. Dragging it to the left 

increases sensitivity, causing less of the slide to be classified as glass, and 

dragging it to the right decreases the sensitivity, causing more of the 

slide to be classified as glass. You can see its effect if a tracking map is 

shown in the thumbnail as you move this slider. 
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Performance Options 
The Performance tab contains several settings that allow you to balance display 

speed with image quality. These settings are provided because digital slides are 

usually too large to fit into memory all at once; therefore, some decisions have to 

be made about how ImageScope will act when swapping data in and out of 

memory from disk. 

 

 Progressive Rendering – When enabled, ImageScope renders image 

views in low resolution first, and then increasingly improves the image 

(by de‐pixilating it) as it reads more image data from the disk or 

retrieves it from a remote server. With this feature disabled, ImageScope 

does not render an image view until the entire view has been loaded into 

memory. 

 Prefetching – When enabled, ImageScope tries to anticipate your next 

view requests and loads those sections of the image into memory. By 

anticipating where you will move next in the image and loading that 

information into memory, ImageScope speeds up the image display. 

 Interpolating (3D images) – Display a weighted average of the two 

neighboring Z‐stack* views for any given Z‐level. 
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 Pixel Smoothing – Uses a high fidelity (but slower) scaling routine. 

HTTP Proxy Option 
Some networks require that all HTTP traffic be routed through an HTTP proxy 

server. If you are using ImageScope inside a network that uses an HTTP proxy 

server, you need to define the proxy server to ImageScope. 

Your network administrator can provide the settings you need for the server 

name, server port, user name, and password. Note: Not all proxy servers require 

a user name and password. 

If you have already created Windows proxy settings on your workstation, then 

ImageScope will use those settings if you select the Use Windows Proxy Server 

Settings check box. 
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Report Image Options 
Spectrum Plus 
Reporting is an 
optional upgrade 
that lets you create 
attractive Spectrum 
Plus reports with a 
few clicks of the 
mouse. The report 
image feature is 
used with this 
product if you are 
using report 
templates that 
contain images.  

A Report Image tab on the ImageScope Tools Options window allows you to 

select a combination of fixed or user selectable sizes and resolutions. Note the 

Fixed Region Size parameters that define the size of the report image rectangle if 

the operator holds down the Control key while selecting the image area. 
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Color Management Options 
Aperio Integrated Color Management takes into account the optical 

characteristics of your ScanScope and your display monitor to ensure digital 

slide color is displayed accurately. For information on color management and 

ICC profiles, see Appendix B, “Aperio Integrated Color Management” on page 

193.  

The ImageScope Options window color management tab is where you can view 

the target monitor ICC profile or choose a new one: 
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Pathology News Options 
The Pathology News tab is where you can configure how often the Pathology 

News window appears: 

 

Enter a number from 1 to 7 in the How frequently to display news. 1‐7 days box 

to select how often the Pathology News window appears (from every day up to 

once a week). 

If you are connected to Spectrum (that is, you have opened an image in 

ImageScope from a Spectrum page) you can turn the Pathology News off and 

prevent it from opening unless you specifically use the View menu View News 

command: 

 Either clear the Periodically Display News check box on the Pathology 

News window or clear the same check box on the Pathology News tab of 

the Options page (shown above). 

For More Information 
For more on ImageScope’s settings, see: 

 Chapter 18, “Utilities and Diagnostics” on page 167. 
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A 
Keyboard Quick Reference 

This section contains a quick reference list of keyboard 
shortcuts you can use with ImageScope. 

ImageScope Keyboard Shortcuts 
Key Sequence Command Toolbar 

Icon 
Action 

Arrow key None  Nudge image. 
Control + None  Zoom in 
Control - None  Zoom out  

Control  
 

Hold down while drawing an 
annotation to draw the annotation 
in a predefined size. 

Control A Image > 
Adjustments 

 

Go to the Image Adjustments 
window where you can make image 
adjustments to the main image or 
to the Z-stack image, as well as 
load and save adjustments. 

Control C None  Enable/disable integrated color 
management 

Control D View > Digital Slide 
Conferencing 
Window  

Open the Digital Slide 
Conferencing window where you 
can create or join a digital slide 
conference. 

Control E Image > Rotate 
Image  Open image rotation toolbar 

Control F None  Turn image prefetching on/off. 

Control F4 File > Close Image 
 

Close the image currently open in 
ImageScope. 

Control G View > Analysis  Run an algorithm analysis on a 
local or remote digital slide. 

Control I Tools > Options > 
Performance  Turn interpolating on/off (used for 

viewing 3D images). 
Control J Tools > Options > 

Performance  Turn progressive rendering on/off. 

Control K Image > Keep Open  Turn Keep Open option on/off. 
Control L Tools > Logging  Turn logging on/off. 
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Key Sequence Command Toolbar Action 
Icon 

Control M None  Show/hide track map 
Control Shift M None  Show/hide cache map. 

Control N View > Annotations 
Window 

 

Open the Annotations window 
where you can work with 
annotation layers for the current 
image. 

Control O File > Open Image 

 

Go to the Open Image window 
where you can browse for a local 
image file to open. 

Control P Tools > Options 

 

Open the Options window to set 
general, navigation, annotation, 
performance, and HTTP proxy 
options. 

Control Q Image > Quality 
 

Turn IQ on/off. 

Control R File > Access 
Remote Server  

Connect to an Aperio ImageServer 
where you can select an image to 
view. 

Control S Tools > Options > 
Performance  Turn pixel smoothing on/off. 

Control Shift   Move all annotations. 
Control T View > Thumbnail 

 
Show/hide the thumbnail window. 

F1 Help > Help 
 

Open ImageScope help. 

F2 None 
 

Pen drawing tool. 

F3 None 
 

Negative pen drawing tool. 

F4 None 
 

Ruler drawing tool. 

F5 None 
 

Rectangle drawing tool. 

F6 None 
 

Ellipsis drawing tool. 

F7 None 
 

Arrow drawing tool. 

F8 View > Annotation 
Link Manager 

 

Open the Annotation Link Manager 
window where you can link slide 
annotations in a specific viewing 
order. 

F11 View > Full Screen 
 

View ImageScope on your entire 
monitor screen. 

Shift None 
 

Hold down while drawing 
annotations: ellipse becomes a 
circle; rectangle becomes a square. 

Shift Arrow  None  Move one screen at a time. 
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Key Sequence Command Toolbar Action 
Icon 

Shift Control None 

 

Hold down while drawing an 
annotation or using the extract 
region tool to create a region of 
the same aspect ratio as the 
predefined fixed annotation size. 

Shift F7 View > Previous 
Annotation Link 

 

If annotation links have been set 
up using the Annotation Link 
Manager, this moves to the 
previous annotation in the viewing 
sequence. 

Shift F8 View > Next 
Annotation Link 

 

If annotation links have been set 
up using the Annotation Link 
Manager, this moves to the next 
annotation in the viewing 
sequence. 
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B 
Aperio Integrated Color 

Management 

Aperio Integrated Color Management takes into account the 
optical characteristics of your ScanScope scanner and your 
display monitor to make sure that colors of the digital slides 
are displayed accurately. 

A challenge for any provider of applications or devices that work with images is 

to make sure that the end result (in Aperio’s case, viewing a digital slide created 

by scanning a microscope slide) gives a true representation of the color of the 

original glass slide from which the digital slide was made. 

Every image capturing device will transform the image color due to the 

particular characteristics of that device. 

Fortunately, there is a way to take those characteristics into account to make sure 

that all along the path the image travels, from creation to display, color accuracy 

is maintained. As of Release 9, Aperio provides Integrated Color Management 

that works with the international‐standard ICC color management specification 

to maintain image color accuracy. 

ICC Profiles 
The ICC (International Color Consortium) is a body that maintains a 

specification defining a color management system that makes sure that the color 

of images moved among applications, devices, and operating systems is 

maintained accurately. 

The ICC defines a format for ICC Profiles, which describe the color attributes of a 

particular device. 

The ScanScope ICC Profile 
In order to describe the behavior of image capture devices such as a ScanScope, 

the devices must be calibrated to a standard UUcolor space, which creates an 

ICC profile. At the Aperio factory, an ICC profile is created for your ScanScope. 

The ScanScope ICC profile is called the source profile. This profile is stored as a 

standalone file in \ScanScope\Profiles on the ScanScope workstation. 

As you scan glass slides, the ICC profile for your scanner is also embedded in the 

resulting digital slide file.  
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The embedded profile tells ICC‐aware applications (such as ImageScope and 

WebViewer) what color‐transformation was done by the ScanScope so that the 

Aperio Integrated Color Management can transform the digital slide to its 

original color.  

The Display Monitor ICC Profile 
The ScanScope ICC profile is not the only component of the integrated color 

management equation. The monitor you use to view the digital slide also has 

characteristics that affect color display. Your monitor may have shipped with 

drivers that contain an ICC profile for the monitor. Or, you can create a new 

monitor profile by using an external calibration tool. As the monitor is the final 

device in the image transformation chain, its profile is called the target profile. 

If a monitor ICC profile exists, the Aperio ICC‐aware applications will use it 

along with the ScanScope’s ICC profile to display the digital slide color 

accurately. 

How ImageScope Uses Color Management 
ImageScope is an ICC‐aware application, which means that—for any digital slide 

that contains an embedded ICC profile—it is able to use the embedded 

ScanScope ICC profile and your monitor ICC profile to ensure digital slides are 

displayed with accurate color. 

For information on how ImageScope uses color management with various 

ImageScope features, see: 

 “Viewing with Color Management” on page 38. 

 Chapter 13, “Saving Digital Slides and Regions” on page 109. 

 “Color Management Options” on page 186. 
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AFI (Aperio Fused Image), 57 

algorithm tuning window, 141 

algorithms, 120 

incremental processing, 120 

Algorithms window, 125 

analysis. See image analysis 

analysis results, 81 

annotations, 75 

adding text, 91 

Annotations window, 86 

changing color, 90 

changing color defaults, 180 

drawing, 75 

arrow, 78 

ellipsis, 75 

free‐form pen, 77 

negative pen tool, 78 

rectangle, 75 

report image, 79 

ruler tool, 77 

fixed aspect ratio, 76 

fixed size, 76 

grid, exporting, 95 

layers, 81, 86 

adding, 92 

attributes, 96 

creating, 92 

deleting, 92 

exporting, 95 

grid, exporting, 95, 96 

hiding/showing, 89 

importing, 95 

visibility, 89 

linking, 99 

panning while drawing, 80 

saving changes, 95 

viewing length/area, 91 

Annotations window, 86 

configuring, 89 

detailed view, 82 

plots, 86 

plots button, 131 

pre‐processing, 85 

quick reference, 88 

summary view, 82 

transparent button, 89 

Aperio Integrated Color 

Management, 193 

arrow tool, 78 

autopanning, 33 

axes and grid, 40 

brightfield image adjustment. See 

image adjustments 

brightness, adjusting, 49 

cache display, 167 

cache settings, 170 

clinical viewing mode, 28 

closing digital slides, 25 

color adjustments. See image 

adjustments 

color balance, 50 

color curves, adjusting, 51 

color management, 21, 186, 193 

ICC profiles, 193 

conferencing. See digital slide 

conferencing 

connecting to ScanScope, 157 

contrast, adjusting, 49 

CWS files, 2 

deleting regions, 86, 121 

diagnostics, 167 

Digital IHC analysis, 81 

digital slide conferencing, 145 

changing leader, 150 

creating, 147 

joining, 148 

viewing slides, 150 

digital slides 

closing, 25 

information about, 21 

opening local, 14 

opening recent, 16 

synchronizing navigation, 31 

viewing multiple, 16 
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windows, managing, 19 

DSR, 6 

extracted regions, 110 

color management, 113 

fixed aspect ratio, 114 

options, 111 

predefined size, 114 

saving specific size, 114 

selecting, 110 

viewing applications, 115 

extraction tool, 110 

false color, 55 

applying temporary, 55 

features, 1 

file types supported, 2 

filmstrip, 19, 35 

fluorescence image, 55 

adjustments, 63 

adjustments, tips, 63 

AFI, 57 

adjusting, 56 

brightness, adjusting, 63 

channel 

cycling display, 61 

hiding/showing, 59 

registering, 65 

viewing information, 60 

color 

adjusting, 62 

hiding/showing, 60 

inverting, 62 

contrast, adjusting, 63 

false color, 55 

fused image, 56 

fusing an image, 66 

gamma, adjusting, 63 

histogram, 64 

high clip, 64 

intensity thresholds, 64 

low clip, 64 

tone curve, 64 

transfer function, 64 

thumbnail, automatic contrast, 63 

free‐form negative pen tool, 78 

free‐form pen tool, 77 

full screen viewing, 31 

fused image 

adjusting. See fluorescence image 

creating, 66 

Genie classifers, 137 

Go To command, 36 

histogram, 64 

HTTP proxy option, 184 

IHC analysis, 82 

image adjustments, 47 

brightness, 49 

color balance, 50 

color curves, 51 

contrast, 49 

fluorescence images, 56 

general tips, 48 

main image, 47 

Z‐stacks, 47 

image analysis 

classifiers, 137 

exporting macros, 128 

exporting results, 123 

generate markup image, 129 

importing macros, 128 

local images, 124 

macros, 133 

markup image, 129 

modifying parameters, 127 

partial, 120 

registering macros, 133 

remote slides, 122 

result plots, 86, 128, 131, 137 

results, 130 

running, 129 

selecting algorithm, 126 

selecting region of analysis, 126 

testing/creating macros, 140 

image information, 21 

image resolution, 71 

computing, 72 

setting/changing, 72 

image rotation, 45 

image settings 

loading, 53 

saving, 53 

image view, 2, 24 

opening, 25 

saving, 24 
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ImageScope 

algorithm tuning window, 144 

disabling pre‐processing, 85 

features, 1 

image view, 2 

installing, 6 

starting, 9 

toolbar, quick reference, 29 

window 

adjusting, 28, 29 

filmstrip, 19 

hiding/showing features, 28 

magnifier window, 36 

quick reference, 27 

status bar, 23 

thumbnail window, 33 

zoom slider, 37 

ImageScope options, 173 

analysis, 176 

annotation, 180 

default gamma files, 175 

general, 173 

HTTP proxy, 184 

integrated color management, 186 

magnification, 174 

navigation, 178 

Pathology News, 187 

performance, 183 

Spectrum Plus report image, 185 

tracking, 181 

ImageServerURL, 155 

installing, 6 

integrated color management, 38 

interpolating, 183 

IQ, 42 

JPEG files, 2 

keep open, 20 

keyboard shortcuts, 189 

label rotation, 46 

Link Manager, 100 

linking annotations, 99 

links 

creating, 100 

deleting, 102 

viewing, 101 

loading image adjustments, 53 

local image analysis, 124 

local image support, 16 

logging activities, 167 

macro image, 23 

macros, 128 

magnification 

changing, 37 

magnifier window. See magnifier 

window 

options, 174 

zoom magnification, 38 

zoom slider, 37 

magnifier window, 36 

changing default resolution, 36 

magnification settings, 174 

resizing, 36 

main image gamma settings, 175 

markup image, 129, 177 

measuring objects, 77 

MRXS files, 2 

multiple ImageScopes, 168 

navigating, 33 

autopanning, 33 

filmstrip, 35 

options, 178 

page panning, 35 

panning, 33 

scrolling, 33 

specific point, 36 

thumbnail window, 33 

NDPI files, 2 

negative pen tool, 78 

opening digital slides, 14 

page panning, 35 

panning, 33 

options, 179 

panning while annotating, 80 

Pathology News, 9 

enabling/disabling, 187 

pen tool, 77 

performance options, 183 

pixel smoothing, 184 

plots 

enabling, 128, 137 

viewing, 131 

Positive Pixel Count algorithm, 120 

Positive Pixel Count FL algorithm, 

120 
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prefetching images, 167, 183 

pre‐processing, 85 

progressive rendering, 183 

pseudo‐color. See false color 

registering channels, 65 

registering ImageScope, 9 

deferring, 9 

registering macros on Spectrum, 139 

report image, 79, 185 

reverse panning, 179 

rotating 

images and labels, 45 

ruler tool, 77 

running image analysis, 129 

saving 

gamma tables, 53 

image adjustments, 53 

image view, 24 

saving image to clipboard, 110 

scrolling, 33 

security, 11 

SlideDat.ini files, 2 

slide‐specific processing, 82 

smart synchronization, 31 

snapshots 

color management, 110 

creating, 109 

Spectrum Plus report image, 79 

starting ImageScope, 9 

status bar, 23 

synchronization options, 178 

synchronizing navigation, 31 

system requirements, 5 

TelePath Live, 155 

calibration, 155 

connecting to ScanScope, 157 

ImageServerURL, 155 

live video, 161 

prerequisites, 155 

thumbnail window, 33 

TIFF files, 2 

toolbar quick reference, 29 

tracking, 103 

appending to a track, 107 

options, 181 

tips, 105 

tracker tool, 103 

viewing track, 105, 106 

updating analyses, 86 

user permissions, 12 

utilities, 167 

viewing 

full screen, 31 

live video, 161 

smart synchronization, 31 

track, 106 

with color management, 39 

VMS files, 2 

VMU files, 2 

Windows proxy server settings, 184 

zoom navigation, 38 

zoom slider, 37 

configuring, 37 

showing/hiding, 38 

zoom, immediate, 37 

Z‐stacks, 157 

calibration, 155 

capturing, 157 

gamma settings, 176 

viewing, 165 
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